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Delcam Designer 1. Introduction

1. Introduction

Delcam Designer Introduction.

Delcam Designer is a hybrid surface and solid Modelling package and has been
created from Delcam’s main CAD package called PowerSHAPE. Delcam Designer
allows complete freedom in 3D design, yet at the same time is easy to learn and use.
Interaction between ArtCAM is such that you have the ability to copy models or
wireframe between the two interfaces.

To open Delcam Designer, double click on the Delcam Designer icon
on the desktop.

Once loaded, the screen looks as shown below.

Menu options. Command selection.

i Delcam Designer 7350 - [NEw_MODEL_17

View
selection
buttons.

View
display
buttons.

I Delcary

Graphics area
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1. Introduction Delcam Designer

ﬁi Delcam Designer 7350 - [NEYW _MODEL_1]

Delcam Designer automatically loads a New Model to work in. The name
(New_Model_1) is given at the top left hand corner.

This model can be saved with a new name or closed so a saved model can be
opened up to work on. Delcam Designer has the ability to have several models open
and data can be copied from one model to another.

At the top of the screen there are a series of pull down menus.

fj‘] Fie Edit W¥iew Object Format Tools Macro  Module  Window  Help

e Select the File menu, using the Left mouse button.

“Fle Edit Wiew Object Format  Toal:
Mew Clrl+h
Open... Ctrl+0
e Drawing...

Open Component Library....
Cloze Ctrl+F4
[Elrse atd ZiE

swe. eS| This menu contains a comprehensive list of operations
ave As... available.

Save Thumbnai

Froperties

Examples...

Frint... Clrl+F
Frink Preview
Page Setup...
Frint ta File....

Feset
Delete. ..

Impart 3
Export 3

Recent Filez 4

Exit Alt+F4

Beneath the pull down menus are the icons which when pressed bring up a form or
do an action. The picture on the icon represents the action it will perform; for
example the one with the floppy disc will save your model.

If you leave the mouse over an icon for a second, a description of the icon will

‘%%ﬁ @ . = “% appear.

= |s5ave Selected model |

To the bottom left is the levels menu.

Bofif20s8[4
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Delcam Designer 1. Introduction

At the bottom of the screen is the Workplane Selector, Principal Plane selector,
the grid definition, the cursor position, the tolerance and the XYZ position input area.

&_.Wmld > 0 :General - E@@%% {@‘ ﬂ| ||-54535 ||315933 ||n | 3 f Tol 001

To the top right are the options Workplane, Line, Arc, Curve, Annotation, Surface,
Solid, Feature, Assembly and Wizards.

LYWWOCPCAIOE

When one of these icons is selected a context sensitive menu appears to the left of
the screen. The context sensitive menu displays all of the options for creating the
type of object selected.

e Select the menu for line creation.

X

/

\\"| The context sensitive menu on the left now shows the options for creating
lines.
D Wiew Object Format Toolz Macro Module ‘'Window He
Layout ...
O Single [of madsl] » \_D ijj Qﬁ
Single [about zelection] L I —
@ Multiple »
Look Fram 3
I Zoom Full F&
Store Views...
J Perspective
Lock Rotation Centre
l Crogs Hair Cursor
Shading 3
Render...
Colour Scheme...
Appearance...
Billboards 3
Blank 3
Unblark Chil+L
Toolbars .
) efresh Chrl+F
All of the toolbars, can also be switched on and off Riebuild
from the View pull down menu and selecting v Views
“Windows b v Levels
Surface/Curve Edit
View =»Toolbars =. o
Cusgtorn 3
General Edit
Model &nalysis
odel Fixing
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Delcam Designer

Delcam Designer Options

The Tools =»Options page allows you to configure Delcam Designer and change

the settings.

Standard lﬁ
- —_ = The options are stored under main
iy F:‘e- Units and Tolerances P lm Categories .
E \élzi:cl Valume: lm
[#- Farmat . H
o el kance o By altering these options you can
o D ki o change how Delcam Designer works
* Maans ( e g o — and you can save these changes so

Angular tolerance

"Surfat:e Discontinuity Tolerance:

that they are used every time you open

—

‘ Delcam Designer. Alternatively you can

Cancel

™ Show difference between user and model options

Help

make the changes just for this Delcam
Designer session.

&1 Dptions ]

- General e
e Properties

Mouse

~ Sawe Time Waming

e Under General select
Properties.

- Kepboard
& Properties

- T ol
- Selection Information
Urits and Tolerances

“warning Time Delay
[V ‘waming Required

—

[~ Long Operation &lert

This is the main control area where
you can save any changes and also
set the time for Delcam Designer to

remind you to save the model.

e Select Cancel.

- Fil

B V‘,:W Long Dperation Time Delay 10

- Dbject ¥ Aot Required

[ Format

- Tools [~ Appearance

[H- Aszembly A lﬁ

- Data Exchange VT SETEE black_on_lightblue

E-Drafting Propaitional Font Microsaft Sans Sert |

- P5-Team .

- Manufacturing Fized ‘idth Fant Courier Mew vI
IC Fort Height l3—

Set Colaur Scheme as Default |

(- Session Options

@ Restart with Default Options
" Restart with Current Options

" Restart with Stared Options

I= | Store Festar Grticrs

™ Quer before starting multiple instances

I | Breload Heverse Engiresring bodil

aK Cancel Help

1.4
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1. Introduction

Help Contents and Index

Delcam Designer has an extensive Help index that can be accessed by either
selecting Help from the top menu or by simply pressing F1 on the keyboard.

%lale o |8l

=

Frint

i

Show  Frevious  [est Back

A

Forward  Home

Welcome to PowerSHAPE

In This Section

Introduction

Getting Started

Bl

Press F1 on the keyboard.

The help is displayed in a new window on the left
hand side of the screen.

A YR

R A
Hide ™ Frevious Wt Back Forward  Hame Print

Contents | index | Search | Favories |

B ) PowerSHAPE reference help
@ welcome to PowerSHAPE
@ rhat's New in PowerSHAPE 7.2
@ Basic Modeling Concepts
@ Advanced Modeling Concepts
@ Menus and Toolbars
@ Wirsframe modeling
@ Surface modeling
@ Solid modeling
@ Assembly modelling
@ Delcam Ciispin SoleDesign
@ Delcam Drafling
@ Delcam Electrode
0 Delcam Render
Q Deelcam Toolmaker
@ Managing your PowerSHAPE spst
@ Custamising PowerSHAPE
... [2) Deloam Ple Software Licence And

In This Section
Introduction

Getting Started

Welcome to PowerSHAPE

e Selectthe home icon '}’ to access
the Learning Assistant and

Interactive Tutorials.

Close the help window using the hide

button in its top right hand corner. =l

Press the Show

Shiowe

button.

Topics are listed on the left side and the
right side displays the help for that
topic.

Select the Index tab for more search

topics.

The Hide button # can be pressed to
hide the topics.

AR

AT R @

Welcome to Delcam Designer

What is Delcam Designer

Delcam Designer is a powerful hybrid solid, surface and wireframe modeller.
Its unique ability to incorporate wrapped 3D artwork into maore traditional
surface and solid models (which we call Total Modelling), to morph models
(like digital clay) and to create ray traced rendered images makes Delcam
Designer the obvious choice for jewellery designers to take their concepts
and make them reality.

i

:E#_’v,

| Learning Assistant

The Assistant lists common tasks and a series of drop down menus provide interactive help as
you work through the tasks. The help is context sensitive and will update automatically as you use
PowerSHAPE. You can access the Leamning Assistant by selecting the Leaming Assistant tab
from the Browser tabs. This is the same as selecting Learning Assistant from the Help menu_

‘ Tutorials

To help you become familiar with the functionality of PowerSHAPE, we have developed a series of
interactive tutorials. You can access the tutorials by selecting the Tutorial tab from the Browser
tabs. This is the same as selecting Tutorials from the Help menu.

& What's new

To help you become familiar with the new functionality of PowerSHAPE. you can access the
What's new by selecting the Help tab from the Browser tabs. This is the same as selecting
What's new from the Help menu.

Issue Designer 7
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1. Introduction Delcam Designer

Mouse buttons

Each of the three mouse buttons performs a different operation in Delcam Designer.
By using the ALT, Ctrl or Shift key, these operations can be extended as the
following details explain.

Left Mouse button 1: Picking and selecting

This button is used for selecting items from the main pull
down menus, inputting and selecting parts of the model.

To select multiple items, either —

Press the left mouse button and hold it down while moving it
over the items you wish to select

OR-

Use Shift+Click or Ctrl+Click to change the selection. Shift
will add items — Ctrl will toggle items — non-selected items
will be selected, selected items will be de-selected.

Middle Mouse button or wheel: Dynamics

Zooming: - Hold down the CTRL key and button/wheel and move the mouse up and
down to zoom in and out of the view. Hold down the CTRL,
Shift Key and button/wheel to select an area by box to zoom
into.

Panning: - Hold down the SHIFT key with the button/wheel
and move the mouse in the direction you want to see.
Rotating: Hold down button/wheel and move the mouse. A
tracker ball shows the rotation as does the view orientation
axis in the bottom left corner of the screen. If view spinning is
on the view will spin around until you click again.

Mouse button 3: Special Menus

When this button is pressed it brings up a new menu based
on whatever the mouse is over. If nothing is selected, the
View menu appears. If a line is selected, for example then the
Line menu appears.

1.6 Issue Designer 7



Delcam Designer 1. Introduction

Exercise 1: Dynamic mouse controls.

For this exercise you will be opening a stored model and then changing the views
around and using the dynamic option.

e Click on File, select the option Open.

& open Model 13 2] x|

Lok in: IBMyDD:umenls j Q2o

Bluetooth Exchange Folder

SiMy PictLres
My Received Files

Wrapper ThIS dla|Ogue a"OWS
. you to browse for a
' model.

lirain tapered ring.psmodel

The model format for
Delcam Designer is

.psmodel.
File name Itraln tapered ring.psmadel j Open
Files of type IAII supported models (*psmodel*.zip) LI Cancel
[~ Open as read-anly
VA

e Locate D:\users\training\Delcam Designer Data.

e Select the model train tapered ring and press Open.

When a model is opened it is shown in a view down the Z-
axis.

The view toolbar, on the right hand side of the Delcam
Designer window, can be broken down into 3 main areas,
standard views, dynamics and shading.

Eﬁ e Select the view Iso 1.
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1. Introduction Delcam Designer

The model is now positioned in an isometric view. To provide better clarity a shaded
version can be shown, instead of the wireframe.

e From the views toolbar select Shaded view pull out menu. @A
e From the available options pick Shaded View.
5O O Q@

The surfaces have been shaded in to make it look like a

N X completed model.
| '

e Hold down the middle mouse button and move the mouse around to
rotate the model.

e Hold down Shift and middle mouse button and pan the model around
the graphic area.

WEDR Object  Format  Tools Macro Module  Window  Help

Layout ...

Single {of model) »

Single {about selection) 3 Top (+Z) Al+5

Mulkiple ¥ Bottom {-Z) Al+0

Look From R Left (-%)  Alk+4

. . . . ight (+) Al

There are many different options for viewing the model that =~z o mcn Al
you can select. There are also a variety of keyboard ES— e
Shortcuts that you can use. LockRotétion Certtre Isn 2 Alt+3

Cross Hair Cursor Iso 3 Al+3

shading ' Iso 4 Alt+7

Render...

Colour Scheme. .

Appearance...

Blank. 3

Unblank. Chrl+L

Refresh Chr+R

Rebuild

Toolbars 3

Windows 3

e Select Views = Single [about selection].
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Delcam Designer 1. Introduction

The keyboard shortcut for the views are listed, i.e. Alt + 1 for Iso 1. By switching
Num Lock on your keyboard, you can use the number pad with the Alt key to
change the views.

There is also a Perspective Mode option, which displays the model in any view as in
real life with the parts nearer the front shown larger while the parts further away
seem smaller.

e Select Back [+Y].

2 Another view is displayed. The Delcam Designer model
needs to be closed. In this case it does not need to be
saved, as the model has not been altered.

B

e Select File & Close.

Query x|
A message box appears asking if
B Do pou want to zave the changes vou made tao train tapered ring? you want to save these Changes. No
changes have been made so the

ves | ho |[cancel | answer is NO.

e Select No.
The model called golf-fin is closed and this leaves the New-Model_1:1 open to work

on if requires. This model needs to be closed to exit Delcam Designer. To close this
model and exit Delcam Designer at once, select Exit.

e Select File = Exit.
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1. Introduction Delcam Designer

Query

1? / Exit Delcam Designer? | A message box appears asking if it is okay to exit
: Delcam Designer.

ez Mo |

e Select Yes.

Delcam Designer has been closed.

Delcam Designer models
Delcam Designer models can consist of a variety of different entities, which fall into
three main types, wireframe, surfaces, and solids.

Wireframe in Delcam Designer

Wireframe items include lines, arcs, curves, points, text, dimensions etc. These can
be 2D or 3D and are essential for drafting in addition to generating most types of
surfaces or solids.

Surfaces in Delcam Designer

Surfaces can be generated from wireframe, created directly as standard primitive
shapes, or by conversion from a solid model. A surface is a skin stretched across
the 4-sided elements of a wireframe network. A 3D model created as surfaces
behaves as a hollow form.

Solids in Delcam Designer

Solids are generated directly from wireframe, created directly as standard primitive
shapes, or by the conversion of a selection of surfaces. A 3D model created as a
solid behaves as an enclosed mass.

1.10 Issue Designer 7



Delcam Designer 2.Wireframe for Design

2. Wireframe for Design

Introduction

Delcam Designer lets you sketch wireframe geometry using any combination of
lines, arcs and curves. Delcam Designer uses a powerful Intelligent Cursor (IC)
that continually feeds back positions, distances and tangency conditions. Once you
understand what the IC is telling you, and how to use it, you will find that creating
even the most complex geometry is fast and efficient.

As soon as you select any object in Delcam Designer, it will become highlighted
(usually in yellow). Depending on the object selected you will also see varying
degrees of ‘instrumentation’ (usually in blue and yellow). This instrumentation allows
you to edit your geometry in a variety of ways, again using the IC.

Wireframe Line and Arc Options

w O

The wireframe Line and Arc options are accessed from the main
toolbar.

#|

4*_':;
&7

i
-

(-
O
K2

Single Line 4

Continuous lines Full Circle

Rectangle Arc Through Three pts.
Polygon Swept Arc About Centre

3D box around selected items Trimmed Fillet

L\ 220

Shortest line between 2 objects Untrimmed Fillet

Trimmed Chamfer

Untrimmed Chamfer

L H&@0CO7%\
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2. Wireframe for Design Delcam Designer

e Restart Delcam Designer from the Desktop.

A new model will be opened in the Delcam Designer session.

Wireframe Lines and Arcs Exercise

The following tutorial will show the basic operation of the Wireframe modeller by
recreating the 2D profile shown below.

N7,
R60.00 BLEND %
o
%
N
R15.00 .
N
/
o
G S
(o} (]
S| R10.00 ¥
=

60.00

100.00
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Delcam Designer 2.Wireframe for Design

Line Creation

A single line will be generated from 0 to Y40 to coincide with the R 15 arc centre.

W / XD Y40 Z0
e From the Line menu select Single Lines.

e Enter the start co-ordinate of 0 and press Return.
e Input the values 0 40 in the Command input box (lower
right of graphics area) and press Return.

Tol  0.01 ||:|4|:| |

X0oyoZo

The next part will be generated using continuous lines.

From the Line menu, select Continuous Lines option. ’7

Snap to the start of the first line (or enter 0 in the command input box).
Input the value 60 in the Command input box followed by Return.

Input the value 40 40 in the Command input box followed by Return.

The Intelligent Cursor (IC)

The Intelligent Cursor displays preview information and locks onto key points and
major directional axes during dynamic wireframe creation.

With the continuous line mode still active, a construction line to locate the R30
centre will be dragged dynamically while being monitored by the Intelligent
Cursor.

Note:- If the Intelligent Cursor functionality does not appear, right click within the
graphics area to open the local view menu and check that the option Intelligent
Cursor is ticked.

e By moving the mouse, dynamically drag the end of a new line away from
the current position (as shown below) and observe the effect of the Intelligent
cursor (do not click the left mouse key yet).

In the diagram the end of new line
wosLgo NAs currently been dragged to a
relative, preview position at an
~angle of 25 degrees with a length
of 60.

Note:- The X direction is 0
degrees and the Y direction is 90
degrees anticlockwise.

Issue Designer 7 2.3



2. Wireframe for Design Delcam Designer

e By moving the mouse further, dynamically drag the end of a new line to a
position tangential to the previous line and observe the effect of the
Intelligent cursor (do not click the left mouse key yet).
5’
* 132 In the diagram the end of new line has
‘ currently, locked onto the tangency of
the previous line and has been
dynamically dragged away with a
IY preview length of 38.

e By moving the mouse further, dynamically drag the end of a new line
position to a position along the Y direction and observe the effect of the
Intelligent cursor (do not click the left mouse key yet).

27
In the diagram the end of new line has

* L.2z  locked onto the Y direction and has
: been dynamically dragged away with a
preview length of 27.

Y

I? - By moving the mouse further,
dynamically drag the end of a new line to a distance of 30 along the normal
(90 degrees) direction and this time click the left mouse key at accept the
line.

The intelligent cursor has locked onto the
*ﬁ--.Lso normal (90 degrees) direction from the end
of last line. The cursor has been dragged
along this normal until a length of 30 is
displayed.
Y The end position is accepted by applying a
left mouse click.

e Press Escape to exit line creation.
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Delcam Designer 2.Wireframe for Design

Arc Creation

The remainder of the wireframe is to be created using various arc options.

e From the Arc Menu O select Full Arc @ .

e Input the value r 15 in the Command input box and press Return.

Tol 001 |rig] (This input will redefine the default radius).

e Move the cursor over the open end of the vertical line until the text End is
displayed then click the left mouse key to snap the circle centre position.

e Press Select. IE

If it is required to modify the Circle, quickly
double click it with the left mouse key and the
relevant Arc editor Form will appear.

e From the Arc Menu O

e Snap on the open end of the construction line, for the centre point.
e Move the cursor to the other end of the line and click with the left
mouse button.

The position is now set for the start of the arc.
nd
B30

Issue Designer 7 2.5
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2. Wireframe for Design Delcam Designer

e Release all mouse buttons and drag the arc around anti-clockwise.

The intelligent cursor displays the current span
angle.

When the left mouse button is clicked, the arc is
created.

/

e Click the left mouse button when the arc reaches about 250 degrees.

The blend radius (R 60) will now
be generated using Create an arc
through three points.

The 1st and 2nd points will be
shapped as tangencies to the
existing full circle and arc with the
3rd point being input as the
specified blend radius value (60).

e From the Arc Menu O

select the Arc through three points
option.

e Use the intelligent cursor to locate, and Click on Tangent points on the
arc and circle (Do not locate a Key, End or Mid point as these are fixed

positions).
w ____.f/'c Ri67 w
>
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Delcam Designer 2.Wireframe for Design

e Drag the radius point to the required shape and to a value as close as
possible to 60 before left clicking for initial acceptance.

e If necessary, In the Arc Confirm form Modify the radius value to 60 and
toggle through Next Solution until the correct shape is achieved, before
pressing OK.

@ Arc Confirm @

Radius

60 Next Salution

The new arc has been
trimmed back both to the
adjacent arc and circle.

The Arc through three points
option will also be used to
create the R 10 fillet between
the line running along Y and
the remaining full circle.

e Select the Arc through Three points option.
e Use the Arc through three points option to create the radius of 10
between the full circle and the vertical line.

Composite Curves

In many applications it is necessary for the required wireframe to be a single entity.
This is achieved by creating the wireframe as a composite curve.
Note:- A composite curve can only by driven along existing model entities.

The basic wireframe shape now is
complete but is currently made up of
several separate lines and arcs.
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2. Wireframe for Design Delcam Designer

The extent of a composite curve can be limited between selected key points along
the potential route (Define start point and Define end point).

e From the Curve Menu, ") select Composite curve. i;'-'

Create Composite Curve @

The composite curve toolbar -
appears. S| > M 10 T -a

e Select the Start Point option in the toolbar and left click the lower left
corner on the wireframe model.

Create Composite Curve

g KA PMHITE @ §vi¥a

“Start Point /

e Left click on the bottom line.

T The Composite Curve is

generated along the route until

Createcompostetuve @ it hits a branch point where

K NIPWITR O 1 viva i\ optional directions will be

\ '! arrowed and change colour for
& the user to manually select the

/ required route.

Note: The asterisk at the start
point indicates that the
composite curve is currently
open.
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Delcam Designer 2.Wireframe for Design

e Left click along the R60 arc.

Create Composite Curve

S MK DO 2 @ 1 The Composite curve has

now continued around the
wireframe back to the
defined Start Point.

Note: a circle at the Start
Point indicates that the
composite curve is a
closed form.

e On the toolbar select Save to accept the composite curve.

£
e Select Eject = to remove the toolbar.

e Select the construction line with the left mouse button.
e From the right mouse button - menu, select Delete.

The wireframe is now complete and will be Saved as a permanent model.

e Select File & Save As.
e Inthe form Save the Model As:-
D:\users\training\COURSEWORK\Delcam Designer-Jobs\cam-example

e Select File =& Close.
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2. Wireframe for Design Delcam Designer

Wireframe Arcs Example

The next example demonstrates the use of Arcs to create the lever design shown
below.

0 o0

g»
T

A
p,

0

10

e Open a New Model

e Select the Arc Menu. O

e Select the Full Arc option from the menu. @

When this command is selected, the centre position of the circle is required first. This
can be input as a value or by snapping using the Intelligent Cursor.

e Inthe Command Input box enter O for the circle centre [o
and press return.

A preview of a circle has been generated with a radius
input from the default value. The radius can be altered by
_ | dragging one of the displayed arrow to the required unit
F-10 value.

To accept the circle, press the escape key.
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Delcam Designer 2.Wireframe for Design

With the circle selected, click and hold the handles (arrows) and

dynamically move the mouse to drag a new radius of 35.

The circle now has the required radius. This method can be
[ - used to create the second circle at the same centre position,

| R using the Intelligent Cursor. Alternatively the user can right
click on the arc and select Modify from the local menu.

e Select the Circle command. @

Position the cursor over the centre of the first circle so the word Centre

appears.

Click the Left mouse button to accept the centre of the new circle.

This new circle is exactly the same initial radius as the
first circle. To change the default, creation radius a new
value is entered into the Command Input window i.e. R
25.

@

Drag the second circle to a radius of 20mm.
The two basic circles are completed. Further circles are
required for this model.

Hint: Use the command input box to enter the circle
centre if it cannot be snapped.

©

Create a circle at centre 100 —20 with a radius of 50mm.
Create a circle at centre 100 —20 with a radius to 35mm.
Create a circle at centre 200 -40 with a radius of 20mm.
Create a circle at centre 200 -40 with a radius of 10mm.
Press Escape.
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2. Wireframe for Design Delcam Designer

90 e

The default option when creating tangent arcs is to trim back the associated
geometry. In this case it is not required to do this, so the flag (Trim Tangent Items)
is switched off. This is found in the Options form under Tools at the top of the
screen.

e Select Tools = Options, select Object then Arcs.

General
File Arcs
wEL_N Diefaulk Creation Mode
=29 ]lz:rtcs (*) Full arcs
Curves () Fitted arcs
Composite curves
Holes () Swept arcs
Lines () Fillet line arcs
Paints
Salids (IFillet line arcs withaut brimming lines
Surfaces
‘Workplanes Default Fillet Radius
Farmat
Tools Confirm Radius
g;:r;?::hange Trim Tangent Items
Diraftirig [Imark Centre of Arc
PS-Tearm
rManufackuring

e Untick Trim Tangent items. [ Trim Tangent Tkems

e Press OK.

For the tangent arcs, the fitted arc option is the most suitable as it provides full
dynamic control through all possible combinations.

2.12 Issue Designer 7



Delcam Designer 2.Wireframe for Design

e From the Arcs menu select the Three point arc option.
e Move the cursor over the outer left circle until the word Tangent
appears and press the Left mouse button.

Tangent
e Move the cursor over the middle outer circle so the word Tangent
appears and press the left mouse button.

Tangent

/”_—\\

i

7N T

e Move the cursor over up and down to get the tangent arc in the correct
place and press the Left mouse button.

-:-"—’-'-_'_—_
R81
The Arc Confirm form appears. This can be used to enter an |/ Arc Confirm X
exact radius. .

e Enter avalue of 75 and press OK. @ hlext Solution |

e "“\l ‘\] N\ The tangent arc is drawn.
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2. Wireframe for Design Delcam Designer

The command automatically repeats until exited by pressing escape or the selector. 4

e Move the cursor over the middle outer circle until the word Tangent
appears and press the Left mouse button.

e Move the cursor over the right outer circle so the word Tangent
appears and press the left mouse button.

e Drag aradius of 225 and press OK.

(O Y)Y /77 0\ The second radius has been generated.
|-" l Vo The further two can be generated in the
’ /| />, same manner.

e Create athree point arc between the left outer circle and the middle
outer circle with a radius of 225mm.

e Create athree point arc between the right outer circle and the middle
outer circle with a radius of 75mm.

e Select File = Save As.

e Inthe form Save the Model As:-
D:\users\training\COURSEWORK\Delcam Designer-Jobs\lever-
example.

e Select File & Close.
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General Edits

At the top of the left hand toolbar are 2 fixed icons, the second of which

includes access to the General Edits toolbar (default).

@ A few applications relating to wireframe data will be illustrated in this section.

‘| Note: The General Edits options are also frequently used on other entities
eﬁ including Surfaces and Solids. Further General Edit options will be
illustrated, as appropriate later on during the course.

e Open a New model.
e Select File - Import and load in the wireframe model:
D:\users\training\Delcam Designer data\ GeneralEdit_Wireframe.dgk

N
N,

— ) ¥
Li'_.,x 50
Q o

The imported wireframe (shown above left) will be modified using the general edits
options initially to produce the 4 finished wireframes (shown above right).

2.15
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&
e Select the Point limit option %a and move the cursor to the end of the
line to be extended and hold down the left mouse key (The cursor will take the
form of a magnet).

e Drag the end of the line tangentially (along the preview line) until the word
Intersection is displayed at which point release the left mouse key,

//

Y K
2 .y

_—
e Select the Interactively limit wireframes option X and left click the
mid-span of any sections of the wireframe network that are to be trimmed
away (as illustrated below).

. —

3

e Create a Composite Curve from the network of lines and arc wireframes
(Hint: For a ‘shortcut’ method hold down the Alt key and left click anywhere
along the wireframe network).
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e With the Composite Curve selected, open the general edit - Move form. %

Move @

[ &

e While the form is open, enter the coordinate values 25 25 in the Command
Input box located at the bottom right of the graphics area.

Y

2. x

The Composite Curve is shifted by 25mm along both X and Y.

e SelectY as the operational axis by selecting the Icon located below the
graphics area towards the left hand side. %% % S

e With the Curve selected, open the general edit - Rotate form. ﬁ

¢ In the Rotate form select the keep original option , enter No of
Copies:- 1, and Angle:- 180 followed by Return.

AL 1 of copmes 1 ¥ Ange | 180 -« 2

-

A copy of the composite curve has been rotated by 180 degrees about the active Y
axis.

Note:- In this case the same result would have been obtained if the curve had been
mirrored about the YZ plane.
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e Reinstate Z as the operational axis by selecting the Icon located below the
graphics area towards the left hand side. % % %‘:’J %

e With both Curves selected, open the general edit — Mirror form. eﬁ

¢ Inthe Mirror form select the keep original option [B and select the
icon labelled ZX followed by Return.

Copies of the 2 composite curves are mirrored about the active ZX plane.

Further General Edit options

Offset
e Select the composite curve located in the -X -Y quadrant @ and
in the General Edits form select the Offset options.

i N

—Ix ”E| @ v Mo, of Copies 1 Iv..' Diskance 10 Iv.l'

e Select the Round discontinuities option Ij and input Distance 10 to
create an offset copy as shown above (The arrow denotes the offset direction
for a +ve Distance value).
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Scale

e Select the composite curve located in the X Y quadrant and in the EEj
General Edits form select the Scale option. -

L.

e Enter a Scale factor of 0.5 to reduce the size of the composite curve by
50% of the original size (as shown below).

R tnrem g - % V5 5

Create Pattern of objects

DD
e With the scaled down composite curve still selected, click the Create DD
Pattern of objects option.

& pattern Edit El
Rectangular | Honeycomb || Circular | Wireframe / / /
B | v v v v v e I I
| vV Vv v v v v / / /
L v v L v v % n n ]
>
Iv v v v v v { / {
50 | .
- v v v v v Y
75 [3 =)
____________ 4 C = . .
Row alignment i_&;_v_ .
[ Hallow Box
=
Co ] [Ceme ] [ The current settings are immediately previewed.

e Input 3 rows along both Y and X with a Y pitch of 50 and X pitch of 75.
e Select OK to accept.
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N 7 / /

af - X

Rectangular is one of 4 main functions in the Pattern Edits form. The other 3 include
Honeycomb, Circular, and along Wireframe. Note: Within each specific Pattern Edit form
further advanced options are available.

]
D) e
(e

e

W

Circular

Wireframe

The General Edits options will be applied as required, later during the course on other
Delcam Designer entities such as Surfaces and Solids.
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Gridding

Often when sketching, it is useful to draw onto a rectangular grid to give an idea of

scale. To activate the grid, click the Grid icon % on the status bar.

LSRGIEERFINE

The default grid spacing is 10mm, but you can change the size to anything you like,
by entering a different value is the box to the right of the icon.

e Activate the grid, and sketch a few more lines. Notice that key geometry
points (end points, mid-points etc.) take precedence over grid positions.

e Turn the Grid Off, and Delete all your geometry.

Note: Selecting the %- icon allows you to switch the IC on/off.

Fillet Arcs

Fillet arcs are used when you want to make a smooth join of known radius between
two items (two lines, two arcs, an arc and a line).

e Draw two lines that join (roughly) at a right angle —

e Click the ‘Fillet’ option ,
(You will almost never use the Untrimmed Fillet command, but it
works exactly the same way).
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Notice that the cursor changes to an arc, and also displays a number (the value of
the radius)

e Move the cursor over one of the lines and see that it changes to read “Fillet
1% Item”.

e Click the mouse to select that line.

e Move the mouse over the other line. The IC changes to “Fillet 2" Item”.

e Click to select that line and create the fillet.

If the radius is the wrong size, you can double—click the fillet to raise the edit form,
and then change its radius.

To set the value of the radius before you create it, by typing R 10

Note that you do not need to put the cursor into the command box. What you type
automatically appears in the box.

] 2 § Toloo1 frio

TIP: To make sure the command box is empty before you type anything else, press
‘Enter’.

e Delete all the geometry you have made so far.

Designing With Curves

As well as enabling you to design with arcs and lines, Delcam Designer lets you
create shapes using smooth, free-form curves.

Bezier Curves

Bezier curves are Delcam Designer’s default curve type.

W O[2]A 9 &
)

raise the curve toolbar. Then click the Bezier icon < p

To create a curve, click on the main toolbar to

e Using the left mouse button, sketch a curve using 4 or 5 points, as below.
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To exit curve creation, press 4l. You can also finish the current curve by double-
clicking the current end point. You can then create another curve.

Note that the IC will operate in the usual way during this process. If there is any other
geometry nearby the IC will let you ‘snap’ exactly to it.

e Delete the curve, and draw this, instead. Note that the span between the
two middle points is to be a straight line.

To draw a straight line segment when creating curves, hold the Ctrl key down as you
click.

Delete the curve, and draw a closed shape. Note how the curve will automatically
change so that the tangent directions of the first and last points match up, giving a
smooth shape. Note also that the cursor changes as you place it over the curve’s
start point, and the IC displays the word ‘Key-point’. Remember that to obtain the

correct closure you must double-click. Then press 4| to exit curve creation.
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Editing Bezier Curves

Delcam Designer allows you to change your curves in almost limitless ways. As soon
as you select a curve, a special toolbar opens, that contains many different editing
tools. For full details of each of the tools, and examples of its use, you can use the
Learning Assistant, which is available from the Help menu.

Select the curve and you will see the individual points marked with small blue dots.
Pick the curve at any of the points. The curve point will become instrumented and
you can make edits to the curve graphically.
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This instrumentation is very important. Curves on surfaces may be edited using
exactly the same techniques. If you look closely at the lines that join the dots you will
see that they are (slightly) different colours.

This is exaggerated in the following diagram.

The lines, and the circles (including the point that defines the curve), may all be
dragged (by holding down the left mouse key while moving the mouse).

e Start by clicking on either of the blue pieces. Hold the mouse button down,
and drag.

This has changed the shape of your curve, by changing the angle at which the curve
passes through the point. This angle is called the ‘Tangent'.
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Now do the same again, but this time, drag one of the purple lines.

This has altered the Tangent angle again, but only on the side you picked. Therefore
the curve now has a ‘kink’ or discontinuity.

As well as allowing you to dynamically change Tangents, this mechanism also allows
you to change the Magnitude of the curve.
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Imagine taking a piece of steel spring and bending it. Now imagine doing the same
with a piece of elastic — or a glass rod. The Magnitude of a curve (or a point on that
curve) controls how stiff or sloppy the curve is. High magnitudes give curves that
resist changes of direction and are ‘stiffer’. Low magnitudes give curves that are very
‘soft’ and floppy.

e Do the drag/move again, but this time grab the circle at the end of the right
hand purple line.

Notice that the shape of the curve becomes very different, as now you are adjusting
both Tangency and Magnitude.

Another graphical edit that you can do is to copy the Tangent and Magnitude settings
from one side of the point to the other. To do this simply click (just one click, do not
drag the mouse) on the bit of blue line on the side whose values you wish to keep.
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TIP: While setting Tangencies, the IC will still allow you to ‘snap’ to other geometry.
This provides a very fast, yet simple and accurate method for aligning curves with
other elements of your design.

The final edit that can be done graphically on a curve is to move the defining points.
Repeat the drag/move exercise from earlier, but this time, pick the point as shown.

The IC will operate as usual during such a move, allowing you to ‘snap’ points to
other elements.

TIP: When moving points in this way, you can also press and hold the ‘X’ or ‘Y’ key
on your keyboard down to constrain the move.
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An Important Edit Flag

At the right hand side of the Curve Edit toolbar which appears every time you select
a curve, is an icon which has a very big effect on how the edits occur.

RIS EAG A

This icon can effectively be either ON or OFF.

M\

-

If the icon is turned ON it looks like this

=

If the icon is turned OFF, it looks like this

To investigate the difference, draw simple Bezier curve using three points, as shown
below.

/"’__\

M

e Turntheicon ON '____"! so it looks like this by clicking it with the left
mouse.

Now drag the middle point of the curve upwards. Notice how the shape of the curve
changes as you do this. The spans to either side of the point are automatically
recalculated to give the smoothest possible curve flow. This is known as ‘floating’.
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N

Now, the tangent angles of the adjacent spans remain unaltered, giving a very
different result.

e Undo the change, and repeat with the icon turned OFF

Sketching Over Concept Artwork

In most cases, designs begin life as concept artwork, either as ink on paper drawing,
or as renderings created in paint-box software. Delcam Designer allows you read
images and use them as templates for sketching geometry in two different ways.

Label Wrapping

Create a simple planar surface by activating the ‘Create Surface’ toolbar.

b WO aRee:
Then pick the Plane option, <>

F |

e Click the left mouse button to create the surface.

e From the top menu bar, select “Format > Labels”.
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Format Tools Macro b

Style Dashed
Style Solid
Levels...
Materials...

Archive Materials...

Transparency
Lights...
Labels...

e When the label selector appears, click ‘New’.

#@llmage Selector

Metallics ' Image Groups

Images

SWARF BRUSHED ISHED ME SHED MET CAST GALVNISD PITTED

WIRE

New

[ 0K H Cancel ] [

Help ]

e Use the next form to browse D:\users\training\Delcam Designer Data

e Select the image deportivo.jpg and then Open.

@ Load Image File

ax]

Lock in: | |23 PS-Designer Training Notes

v o2 =@~

) pics
@ 4 ~g-wireframe_for_designers.doc
=l ~WRL0168.tmp

Jph 811 00-pshapefront.doc
1 01-contents.doc

. 1 01-intro.doc
W n2-wireframe.doc
1 02-wireframe_for_designers.doc

My Computer | | ] 03-workplanes.doc

¥ 04-Parametrised Surfaces.doc
1 05-Power Surfaces.doc

| 1 06-Surfaces from Wire.doc
1 07-editing.doc

108 -Twisted collet exercise.doc

8710 - twisted ring exercise design.
{7 36-metal_pendant-1.jpg
iz deportivo.jpg
4 Pendant.ing

T| Dimensions: 677 x 277
Aty Type: IPG File
Size: 145 KB

Places 8109 - ring design exercise.doc
. [( ] i
:_:I File name: ‘depurlivu.jpg
Transfer (H) | Fjeg of type: (Al Files (-

[~ Open
[ae] L{_m_}'
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Delcam Designer

' Label Selector
Labels
deportivol
Hew ] [ Edit ] [ Delete ] [ Apply ] [ Remaove
[ oK ] [ Cancel ] [ Help ]

If necessary, adjust the size of your images, or its orientation, using the sliders.

When you are happy with the re

@ Label Editor

sult, click ‘OK’.

Flane + | Projection

Standard04 | Material

[¥] True Size
Label Layout

[T Mirror u
o (1 Mirror v
[ Tiled

Label Size

Image Background
0 Red

0 Green
0 Blue

[ Transparent

X Size
J 0.000 J 0.047
J Y J Aspect

0.000 1.000
J Anale

0K I[ Cancel ][ Help ]

JokE

B
| |

You can now sketch directly onto the surface to create your curves and other
wireframe geometry, using the image as a guide.

Note that the image does not have to be wrapped onto a simple plane. You can wrap

an image onto a more complex shape to allow creation of 3D curves.
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Billboards

As an alternative to label wrapping, you can instead sketch onto billboards.
Billboards are more flexible as you can define up to 6 separate images to represent
different views of the design (front, top, left, right and so on).

Before you can create a Billboard, you need to define the plane or surfaces onto
which you are going to sketch. Create a single Workplane at the origin.

2 90 LW O -

e Click a position on the screen.

TIP: Rather than simply click on screen to establish a position, you can enter exact
values. Typed values automatically appear in the Command Window. Numbers are
entered in the order X, Y, Z but you only need enter enough numbers to make the
value unique.

Entered Value Values Used
10 10,0,0
010 0, 10,0
0010 0,0, 10
Y
X

e Select the Workplane, the choose “View .. Billboards ... Create” from the
top menu.
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View Object Format Tools Macr

Layout ...

Single (of model)
Single (about selection)
Multiple

Look From
Zoom Full =]
Store Views...

Perspective
Lock Rotation Centre
Cross Hair Cursor

Shading
Render...

Colour Scheme...
Appearance...
Billboards

Blank
Unblank Ctrl+L

Refresh Ctrl+R
Rebuild

Toolbars
Windows

[

[

v Show Billboards

Create...
Edit...

The ‘Create Billboard’ form opens, from which you can specify the direction(s) for the
view, and the Image(s) to use.

@1 Create Billboard

x Billboard exists

MName View
Billboard_1 Top(+Z) v
[ Apply ] [ 0K ] [Dismiss] [ Help

|

e Click the ‘Image’ button and locate D:\users\training\Delcam Designer

Data.

e Select the image Pendant.jpg and then Open

2.34
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x Billboard exists

Mame View

Imaoe
' Billboard_1 | [Top(+2)

[ Apply | [ pismiss | [ Hep |

If the orientation or size of the image is not what you want, you can edit the Billboard,
by selecting “View... Billboards...Edit” from the top toolbar.

[View Object Format Tools Macr

Layout ...

Single (of model) r
Single (about selection) *
Multiple >
Look From »
Zoom Full F&

Store Views...

Perspective

Lock Rotation Centre
Cross Hair Cursor

Shading P
Render...

Colour Scheme...

Appearance...

v Show Billboards

Blank » Create...

nbonk cutt | GG

Refresh Ctrl+R
Rebuild

Toolbars »
Windows [

From the edit form you can change the attributes of the image to achieve the desired
result.

Issue Designer 7 2.35



2. Wireframe for Design
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Name Billboard_1
-Tlr:EJmsparency - Rlﬂ;‘,late
J J

~Move Horizontally

~Scale Horizontally

=) =)
T T
: 1] : L]
~Move Vertically ~Scale Vertically ——
- -
T T
1] 1]

Ch _ i C _ ]

[ Apely | |

QK

| | Dismiss |

[

Help

)

Once the Billboard is in place, use any of Delcam Designer’s sketching tools to
create accurate wireframe geometry.
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Appendix - Other Types of Curve

Delcam Designer uses several different types of curve, and (unfortunately) in order
to understand the differences we need a little theory.

There are three classes of curve, known as Go, G; and G». All curves are composed
of a set of defining positions, known as ‘points’. The distinction comes from the way
the curve behaves as it passes through each point.

A G curve has positional continuity. The ends of the span leading to and away from
the point are in exactly the same place. However, the two spans may point in very
different directions. If this type of curve were used in a surface you would see a
crease. In the figure above you can see the sharp change of angle.

A Gj curve has tangent continuity. The curve exits the point in exactly the same
direction as it enters. If you used this type of curve to construct surfaces you would
not see a sharp edge. However, under certain lighting conditions you can still see
what is usually known as a ‘hard edge’ due to the way light is reflected. In the figure
above, you can see that the curve’s shape changes as it passes through the mid-
point.

Issue Designer 7 2.37



2. Wireframe for Design Delcam Designer

A G, curve has curvature continuity. Not only does the curve stay in the same
direction as it passes through the point, but the shape of its trajectory is exactly the
same either side. If you were to replace a segment of curve with arcs that were a
perfect fit, this type of curve would have identical radii either side of the point. A
surface made with this type curve has no visible transitions between adjacent
segments, but is smooth and free-flowing. This type of surface (known as an ‘A-
class’ surface) is typically found in automotive bodywork.

Delcam Designer offers all these types of curve, and has extensive tools for editing
them too, to help you achieve the perfect shapes. For most applications Go and G;
curves give perfectly acceptable results. The type of curve you use will depend on
the object you are designing.

NURBS

A NURB is a special type of curve that maintains a smoother shape than a Bezier. A
NURB curve cannot have a discontinuity, and you also have less control over the
ways in which the points can be edited after the curve has been created.

e Click the NURB icon, from the Flyout. ) s
< 2 O~
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G, Curves

Delcam Designer can also make G, curves in
the same way. Click the G, icon é

When editing a G, curve, the curve will always retain its curvature continuity.
Therefore it is not possible to make the curve have any kinks.
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3. Workplanes

Workplanes

Workplanes are user defined, local datum points, which are positioned and aligned
as required to simplify modelling. The model can contain several workplanes, but
only one can be active at any time. When a workplane is activated it becomes the
XYZ datum and changes colour from grey to red. Model entities can be copied or
cut from the currently active workplane and then pasted back in a different
position, relative to a newly activated workplane.

The main Workplane icon is located in the main toolbar which when selected will

provide the following icons in the left hand toolbar:

L Single Workplanes.

Multiple Workplanes.

L.L.

Single Workplane aligned to geometry.

f_L“E' V’_l‘E‘ o s 7 Single Workplane at Top/Centre/Bottom of selection.

L:_, Workplane from three points.

¢’$ Create Points.

In the next example the user will be required to apply wireframe Lines to construct a box
with an angled top. This in turn will be used as the model to demonstrate some basic
applications of Workplanes.

Box Example pd
e Open a New Model.

AR

The wireframe for the dimensioned form (as
shown right) will now be created.

ASY

Issue Designer 7 3.1



3. Workplanes Delcam Designer

e Open the Single Workplane option and enter 0 into the Command
Input window to position it at the World Datum.

e Select the view Isol. @

e From the Line menu ‘ select Rectangle.
e Enter 0inthe Command input box and press Return.
e Enter 100 75 in the Command input box and press Return.

Note:- The rectangle is not a single
entity but consists of 4 separate,
wireframe lines.

From the Line menu select Continuous Lines.

Snap the start of the line onto the Workplane.

Enter 0 0 100 in the Command input box and press Return.

Enter abs 0 75 150 in the Command input box and press Return.
Snap (left mouse click) the end of the current line to the top left corner of
the rectangle (Marked as End by the Intelligent Cursor below).

150

e Select the last 3 lines created.
e Open the General Edits - Move option.
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e Select the option Make a Copy and enter 100 in the command input box
before pressing Return.

Fin
o

The final 2 Single lines are input by snapping to appropriate key points on the wireframe
model.

e Select Single Lines. /
e Press Escape.

End

The main wireframe model is now complete.

L:100

An additional wireframe model based on a
hexagonal Polygon of lines will now be created
to a new Workplane coordinate system at X -100
away from the main model. A copy of this
separate model will later be placed onto the
angled, top face of main model.

N\
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i

Open the Single Workplane option and snap a new Workplane to
the top End of the line running up Z from the original Workplane.

Zoom into the new (Active) Workplane and then use the left mouse key to

select it.

When a Workplane is selected a square appears on
the XY plane. The corners and mid points of the
square, along with the Z axis arrowhead are thicker
and darker in colour.

If the left mouse key is held down on one of the
dark bands then the Workplane can be dynamically
rotated about the Z axis.

If the left mouse is held down one of the lighter
coloured bands then the Workplane can be
dynamically rotated about the corresponding,
parallel X axis or Y axis.

Note: If one of the Workplane arrowheads is
selected (instead of a coloured band) during
dynamic re-orientation then all Workplane axes
will rotate simultaneously.

3.4
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e Select the light band on the +Y side and parallel with the X axis and with
the left mouse key depressed drag and drop on to the upper left corner of
the model (arrowed above).

e Select the 4 lines (Use Shift - left mouse for multi-selection) enclosing the
angled top face of the model and select the Workplane option - single
workplane at centre of selection.

“N
-
\{P
< \% XN As soon as the icon is clicked a new Workplane
IS created, central to the 4 selected lines.
This Workplane will both be Active and
\ > selected.
o~
™
\wzx
X
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From the main toolbar select the Arc options and create a 40 radius - Full
Arc about the currently Active workplane.

Y - The R40 Circle has been created on the XY plane of the
\}J’ Active workplane central to the angled top face of the
wireframe model.
Y'a/
|~

z

L

Right click on the Active Workplane to open it's local menu and untick
Activate. As no Workplane is now Active all measurements will now be
controlled by the original World coordinates.

Open the Single Workplane option and enter -100 into the
Command Input window to position it (along -X) away from the main
model (The new Workplane will become Active by default).

Create the following network of wireframe lines central to the new
Workplane.

Hlnt' 'a Polygon
Use Lines — Polygon.

In the Command Input box, Input (and return) 0
(Centre point) followed by 0 15 (corner point).

Mumber of sides &

(#) Centre point and comer point
"3 Centre point and edge midpaoint
{3 Edge points

Flip

[ Create composite curve

I Fillet radius o
LM I [ ok J[ Hem |
i
| Z e X
This wireframe will be copied from the
Workplane local to the geometry, to the
Workplane central to the angled face on the
2 0 main model.
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e With the above workplane Active, select all the new locally created
wireframe and with the cursor on one of the lines, right click to open the
local Selection menu.

selection

Cuk

e Select Copy in the menu.

Paste

Paste Special
Delete

The selected wireframe is

izses e 2ttt effectively, copied via the mouse!

Clear Selection
Select all

e Activate the workplane positioned central to the angled, top face on the
main wireframe model.

e Right mouse click in the graphics area away from the model and select
Paste from the local menu.

Yiew

wireframme
Shaded

Shaded Wreframe The wireframe created away
Dynamic Hidden Line .
Tnside Materia from the main model has been

e Wirefrane Colow copied relative to the workplane
central to the top angle face of the

main wireframe model.

<

Drynarnic Seckioning.. .

Y Lock Rotation Centre

Paste Special
oo seeton Note: Data relative to an Active
Toktome workplane in one PowerSHAPE
_week | model can be copied and pasted
e “Z:L relative to an Active workplane in
Redo a different PowerSHAPE model

v Inteligent Cursar

v Drag Move

e From the main pulldown menus select File — Save As, and store the
psmodel as:-

D:\users\training\COURSEWORK\Delcam Designer-Jobs\Workplane-Box

Issue Designer 7 3.7



3. Workplanes Delcam Designer

3.8 Issue Designer 7



Delcam Designer 4. Surface Modelling

4. Surface Modelling

What is a Surface?

A surface is best described as a skin of negligible thickness stretched across a defined 2D or
3D area.

There are 3 main types of surface supported by Delcam Designer which include:-
Primitives, NURBS and Power Surfaces. The constructional attributes and editing
capability of these are very different.

Primitive surfaces

A Primitive Surface is based on simple, standard shapes, and wireframe extrusions or
rotated forms. A Primitive Surface is defined or edited by entering set parameters into a
specialist form (The actual input criteria depends on the type of Primitive Surface).

A major restriction of a Primitive surface is that it is only possible to modify the existing
defined parameters such as length, radius, orientation and where applicable, the original
wireframe. Primitive surfaces also have an inherent workplane like datum, which the user
can manipulate to perform modifications dynamically.

Delcam Designer - Primitive surface options include:-
Primitive - Plane, Block, Sphere, Cylinder, Cone, Torus. Helix.
Extruded surfaces (From pre-defined wireframe).

Surfaces of revolution (From pre-defined wireframe).

Mame [ 1 1
Top Radius |715 i
Base Radius 30 J

Length lE'U i

(o4 ” Cancel H Help ]

The Primitive Cone is shown left selected with the local Cone editing form open.
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NURBS surfaces (Non-Uniform Rational B-Spline)

It is common for a surface model created using a different CAD system to be imported into
Delcam Designer. For this to be possible, Delcam Designer supports other types of Surface
definitions such as NURBS surfaces. PowerSHAPE will also create NURBS surfaces
during certain applications or if dictated by the user in the Delcam Designer - Surface
Options.

The control points on a NURBS surface can be dynamically moved around in space, but not
to any degree of dimensional accuracy.

Any such changes are tricky to apply and depend on the users visual acceptance of the new
form.

Conversion of Primitives and NURBS to Power Surfaces

If it is required to perform more complex modifications to the shape of a Primitive or
NURBS surface, it must first, be converted to a Power Surface. With a Power Surface the
user has access to a full range of editing options via a comprehensive surface/curve editing
toolbar or dynamic operations.

Note:- It is not possible to convert a Power surface back to a Primitive or NURBS type.

In the Main pulldown menu option:-

Tools — Options — Objects — Surfaces ensure that in the section labelled Primitives that
Create as NURBS is unticked if direct conversion from Primitives to Power Surfaces is
required (Otherwise when Convert Surface is applied to a Primitive it becomes a NURBS
which in turn will have to be converted to a Power Surface).
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Note:- Several of the Surface creation options directly create a Power Surface.

Power surfaces

A Power surface is based on a network of 4 sided wireframe elements appearing as curves
along (longitudinals) and across (laterals) the surface area.

A Power Surface can generate complex forms while retaining full editing capability
including the direction and magnitude through surface curve intersections.

To define holes within the surface area or an outside profile not compliant with a 4 sided
wireframe structure, specialist trim curves called Boundaries are applied.

The area of surface between adjacent pairs of laterals and longitudinals is called a patch.

The curves on a POWER Surface are called longitudinals (along the surface) and laterals
(across the surface). In some cases another (optional) curve exists called a spine. This
generally runs along the longitudinal direction, often in free space controlling the orientation
of the laterals.

Laterals
This surface contains the minimum,
two laterals.

Longitudinals
This surface contains a total of 7

longitudinals flowing from
corresponding points from the first
to the second lateral

Spine (Drive Curve)

The spine (shown dotted) is used to
control the orientation of the
laterals. A spine is not mandatory
and can be created or deleted as
required without changing the
surface shape. It occurs
automatically such as during the
creation of Fillet surfaces or as part
of the controlled geometry of a
Drive Curve surface.

The Cato mark identifies the start point for Laterals and Longitudinals on a POWER surface.
It is positioned a short distance from point 1 along lateral 1 with a short line pointing from it
representing the Longitudinal direction.
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Basic Primitive Example

e Select Create New Model. %ﬁ CO

e Select the Surface menu icon from the Main Toolbar.

Q

e Move the mouse over the Surface Primitives fly-out commands.J
This menu allows the user to create a
range of surface primitives. They are, from Q

left to right, Plane, Block, Cylinder, Cone, ‘a Q b O

Sphere and Torus.

e Select Plane Primitive. j

A moveable Primitive Surface - Plane is attached to the cursor, with the centre of
the Plane being it’s local origin. This can be positioned by locking onto an item using
the intelligent cursor or by typing in X Y Z co-ordinate value in the Command
Input window.

e Enter 0 inthe Command input box and press Return.

e Select the view Isol. @

The selected Plane is shown is positioned
/ Z§ with an inherent workplane attached to it.

The orientation of the Primitive Plane can

be changed dynamically by selecting and
\< dragging on workplane attributes.
\ / The sides of the actual Plane can be

dynamically dragged to a different size.

e
I

e Select the blue edge at the top of the square and dynamically pull it out
wards until a value of 280 is displayed and release the mouse button.

Length 2875 |

/ W The width can also be modified at this point
\ using the same method.

\/
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e Select the blue edge at the side of the square and dynamically pull it
outwards to 100.

e Double click on the Plane to open it's editing form.

x|
Dimensions | workspace |
IHarne
width () ER This form has two tabs and allows the user to rename
i — or reverse the surface, input different values for width
~ and length, re-orientate directly along a major Axis, or
.. = = by e}pplylng a twist about a major Axis to change the
angle.

e Change the Length (Y) to 100.

e Select the Workspace tab and change the define Z position to 40 before
selecting OK.

e Press Select 4 to exit Primitive Plane creation mode.

This Plane will be used as part of the next example, so do not delete it.

Simple design using Primitives

In the following example each of the six Primitive Surface options will be applied to
the construction of a basic Gear Shift design.

e

=

R15

Dia 10

150
160

90

40

Dia 55
100
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e Click the Workplane icon L’ and the option Single Workplane. L’
e Enter 0inthe Command Input box and press Return.

This Workplane will provide a visual marker for the dimensional datum.

e From the Surface fly-out menu ‘0 , select Block Primitive. ia

e Enter 0inthe Command Input box and press Return.
e Drag or Edit the Block dimensions to X 100, Y 100 and Z 40.

e From the Surface fly-out menu & , select Cone Primitive. (’)

e Enter 0 040 in the Command Input box and press Return.

e Drag or Edit the Top Radius to 5, Base Radius to 27.5 and the Length to
be 50.

e From the Surface fly-out menu ‘0 , select Cylinder Primitive. i
e Enter 0 0 90 in the Command Input box and press Return.
e Drag or Edit the Radius to 5 and the Length to 60.

e From the Surface fly-out menu & , select Sphere Primitive. O
e Enter 0 0 160 in the Command Input box and press Return.
e Drag or Edit the Radius to 15.

e From the Surface fly-out menu ‘0 , select Torus Primitive. @
e Enter 0 0 90 in the Command Input box and press Return.
e Drag or Edit the Minor Radius to 1.5 and the Major Radius to 6.5.

e Press Select 4 to exit Primitive Plane creation mode.
e Select File - Save
e Search Location D:\users\Training\Coursework\Delcam Designer Jobs

o Enter name GearStick.psmodel and select Save.
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Extrusion Surfaces

An Extrusion Surface uses the shape of a selected wireframe entity, and extrudes
it as a surface, normal to the wireframe’s planer base (default). If required, it is
possible to change the settings in Tools — Options — Objects -Surfaces for the
extrusion surface to generate along the active major Axis. If several items are
selected for extrusion then a separate surface will be generated for each. To create
as one surface, the wireframes must first be merged into a single entity, composite
curve.

As with standard Primitives an Extrusion Surface can only have basic parameters

modified unless it is irreversibly converted into a Power surface in which case a
more comprehensive editing toolbar is available.

Extruded Polygon example
This example demonstrates the option to create a wireframe, polygon which in turn

will be used to generate an octagonal extrusion surface with a side length of 50
and a height of 100.

e Select Open New Model. %ﬁ

e Open the Line menu. W O

e From the menu select Polygon.

{ Polygon . x|

Mumber of sides I ]

The polygon creation form is displayed. This allows you

@ Centre point and cormer point to specify the number of sides points to define a
" Centre paint and edge midpaint polygon that fits a circle around the outside.
" Edge points . . .
- The option to automatically generate a composite curve

is useful as other commands, such as extrusion require
a composite curve. If this option is switched off the
Fillet radius |D polygon will be made up of single lines.

(o4 | Help |

[~ cCreate camposite curve

e Setthe Number of sides to 8.
e Select Edge points and tick - Create composite curve.

Start and end points of the first span need to be defined before dismissing the form.
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e Enter 0in the Command Input box and press Return.
e Enter 50 in the Command Input box and press Return.
e OK the Polygon creation form.

The wirefame is completed and is already a single
closed composite curve.
This will be used as the shape of the Extrusion Surface.

e Select the view Isol. @

e Select the composite curve.

O

and select Extrusion. ~ ~

e Select the Surface menu

This produces an extrusion surface
from the selected composite curve up
the Z-axis by a default value.

The extrusion has two sets of Double
Arrows which are used to dynamically
change the length up or down the Z
axis and if required to create a negative
extrusion (lower set).

e With the Left mouse button select the upper set of double arrows. %
e Drag the extrusion upwards to a length of 50.
e Double-click on the surface edge.

/ Extrusion =

Dimensions | warkspace | Sketch |
Nare o The Primitive Extrusion editing form will open providing
Length [0 the option to input settings and dimensional values. The
Dftarge [0 Extrusion can be given a positive or negative draft angle.
o The Keep option will restore the original wireframe used to
Lo = || generate the extrusion.
ok | cancal | b |

4.8 Issue Designer 7



Delcam Designer 4. Surface Modelling

The extrusion can be repositioned by entering new origin coordinates, and aligned
to, or rotated about an Axis.

e Enter alength of 100 and press OK.
e De-select the surface by clicking away from the
surface.

The Extrusion Surface is completed.

Surfaces of Revolution Example

A surface of revolution is creating by revolving single geometry or a composite curve
around a specified principal plane.

L0
Hl

e Select Open New Model %ﬁ

e Create a Workplane at 0 and create the B0
bottle section geometry.

This shape will be connected together with a
composite curve.

S0

This curve will be revolved by 360 degrees around
the workplane generating a surface. The correct axis
for rotation around must be pre selected. Y

e Select the Y-Axis % I% %j &

e Create a composite curve of the section geometry.

e Select the wireframe and select the Surface menu. &

&

e Select Surface of Revolution.
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The selected composite curve is spun
around the active axis (Y) producing the
surface of revolution producing the bottle
shape. If a lid was required on the open
end of the bottle, this can be made by
capturing the end curve and using the Fill
in surface command.

To capture the end curve a composite
curve is required.

Automatic Surfacing Wizard

Several of the Delcam Designer surface creation options have been included into an easy to
apply, Automatic Surfacing Wizard. If the user selects wireframe before opening the
wizard then the most likely surfacing method is selected ready to be previewed and/or
applied. If an alternative, valid surfacing method is required then the user can toggle to it by
opening the list of options and clicking on the downward pointing chevron.

Surface Ywpe Method

Options

Automatic Previewing

Tangent ko Surfacels)

[ CompCurye Creakor ] [ < ] Frorn Metwork, w [ o ]

From Mebwork,
2 From Separate
P Appl oK | Help |

[ ezt ] [ EEY H ] Developable 28
Drive-Curve
Twio Rails
Flane OF Best Fit
From Triangles
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Fill-In Surface

A Fill-in surface is usually created from one or more enclosed wireframes. It can also be
created from open ended, wireframes as well as Point data.

Example a N

e Create a wireframe, Rectangle of lines from the 0
datum with sides of X50 and Y75.

e Create R 15 fillets at both of the top corners.

e Select all the wireframe entities. ‘& ‘
e From the main toolbar select the Surface icon. V&
¢ Inthe left hand toolbar select the Automatic Surfacing option.

& Automatic-S urfacing

Surface Type

The most obvious option for the selected
wireframes, Fill-in will appear in the form.

Options

Aukomatic Previewing

v
l CompCurve Creator ] Fill-In w

[ Presview ] [ Apply H [s]4 ] [ Cancel ][Ad vvvvv d] [ Help ]

e Check that Fill-In is the selected surface creation option and Apply.

A Fill-In surface will is patched inside the enclosed
wireframe.

e Select and Delete the Fill-in Surface. ‘IC» ‘
e From the Main toolbar select the Workplane options.

e From the workplane toolbar select the Create a point option. ‘ ‘Q}‘
e Inthe command input box enter the following 5 co-ordinate positions
pressing the Return key after each one to accept:-

25 37.5
15 15
15 60
35 60
35 15

o1 o101 01O
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Select all of the wireframe including the 5 points.
From the main toolbar select the Surface icon.

In the left hand toolbar select the Automatic Surfacing option.

Surface Type Method

The most obvious option for the selected wireframes,
Fill-in will appear in the form.

Options

[¥] Automatic Previswing

[ compcurve Creatar | Fil-In P

[_preview | [ ety | [ ok | [ concel | [advanced | [ e |

e Check that Fill-In is the selected surface creation option and Apply.

s The Fill-in surface has blended through the selected point
’ data as well as the outside wireframe.

Drive-Curve Surface

spine

A Drive Curve surface consists of a spine curve along
which section curves, are aligned perpendicular relative
to the spine points. The illustration left shows a Drive
Curve Surface using a single section curve running
along the whole length of the Drive Curve.

Minimum requirement is one sectional wireframe
positioned anywhere along the single Drive Curve.

section

e

sections ) £
The illustration right shows a closed Drive
Curve Surface with 2 different shaped
section curves strategically attached to the
spine points. / v
k%\\:::i: 5 %Ine
m‘"‘h--_.___...-r—-*/

—

N,
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Racket Example
The first step is to create the wireframe for the drive curve of the tennis racket.

e Create a workplane at 0 and then construct the following wireframe.
This shape will form the single drive
curve along which the surface will be

generated.

Wireframe sections will be defined,

[ in this case, perpendicular to and at
strategic positions along the drive
o curve.
o
N Upper Section
1 R25.00 Blend
j -
10.00
b R350 BLEND
— ©16.00 $ , 10.00
|
R4.00 x 2
24 PARALLEL

e Create a workplane and position it at the midpoint at the top of the racket.

e Zoom into the area around the new workplane.

e Select the X principle plane. % WS

e Generate three circles, circle 1, radius 8 at Z 0, circles 2 and 3, radius 4
at0010and 00 -10.

These will be joined by using 4 fillet arcs of radius 25. During this process

. it will be advised to split the existing circle of radius 8 into 2 separate arcs,
' if the default automatic trimming is active.

AN
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e Fillet the circles with an arc of radius 25.

This will be the main centre section of the racket.

The other sections are circles and they can be placed directly at the grip end,
without the need for another workplane.

Select the Y principal plane. % I% % %

Generate two circles of radius 10 with their centres snapped to the end
of the lines.

2

The Drive Curve and each Cross
Section must be single entities before
the required Drive Curve surface can
be produced. The sections are already
single Full Arc entities but the Drive
Curve is a series of arcs/lines which
must first be made into a single
composite curve.

e Create a single composite
curve out of the Drive Curve

entities and mid section entities.

Select all three sections and the drive curve.

A%
N
wh

From the surface menu @ select the surface wizard.

£ Automatic-surfacing

rSurface Type

The surface wizard recognises that the
wireframe selection is suitable for
creating a drive curve surface and
changes the pull down menu accordingly.
A preview of the surface is also
displayed.

% Fowersurfacels)

€ NURES

 Opkions

Iv automatic Previewing

7| Tangent bo Surfaces)

CompCurve Creataor | = ||Drive-Curve j = |

Presigw | Apply | OF | Cancel | ndvancedl Help |

e Click OK.
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This generates a surface with a changing
section from the first circle to the defined
section and then back to the last circle.

e Select File=» Save As:-
D:\users\training\COURSEWORK\Delcam Designer-Jobs\my-racket

e Select File & Close.

Surface From Separate Curves

If separate curves are selected the Automatic surfacing wizard will use create a surface
From Separate curves option.

The separate curves are defined across the surface (laterals), which are then linked with
curves of best fit along the surface (longitudinals).

Lateral Curve Example

e Create a workplane at 0.

e Create a continuous line from the workplane, 10mm in Y, 10mm in X,
and 10mm in -Y to produce the 'n-shape'.

This section will be the basic for the other sections so it will be
copied up the Z-axis as individual lines.

iy X

e Select the three lines.
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&
« From the Edit toolbar * " select Move/Copy Obiject. %A

This opens the Move form.
[D Mo, of Copies 2 W @

e Enter 2 for the number of copies and the value of 0 0 5 in the position
window, giving you three sets of lines.
e Dismiss the form.

Each composite curve will be filleted
by a different radius.

Make composite curves from each set of lines (Alt key and left click).
Create a fillet radius of 1mm on the bottom curve.

Create a fillet radius of 2mm on the middle curve.

Create a fillet radius of 3mm on the top curve.

An additional two curves will be copied to produce a total of 5
curves.

e Select the lower composite curve and Move/Copy it up the Z-axis by
20mm.

e Select the second from bottom composite curve and copy it up the Z-
axis by 10mm.

All of the shapes have been turned into composite curves, ready for
surface generation. Each of the composite curves will be turned into
a lateral on the surface.
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e Select all of the composite curves..

e From the surface menu o select the surface wizard. f"i 2

4 Automatic-Surfacing

—Surface Tvpe

& PowerSurface(s)

The Wizard analyses the selected
wireframe and selects the surface type
to be created as From Separate

" MURES

~ Opkions

¥ Automatic Previewing

e OK the form.

™ Tiamgent ko Surfacels)

CampCurve Creataor | <= ||From Separate j = |

Preview | Apply | oK | Cancel | F\dvancedl Help |

The surface From Separate curves is as shown left.

e Select File = Close and select No. (to Save)

Surface from Two Rails

A surface can be generated from a section, which is scaled along two drive rails, defining
the edge of the surface.

/

Section
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The section is scaled across corresponding points along the drive rails to generate the
surface. Drive rail pairs must contain the same number of points and can both if required
form a closed loop. The end points on an open section must be positioned exactly on the start
point of each drive rail. Both the section and the drive rails must be defined as composite
Curves.

Surface from Two Rails Example

e Select File > Import and then select the model:-
D:\users\training\Delcam Designer data\ two_rail_data.dgk.

Drive rail curves

Section curve

e Double click on one of the drive rail curves to bring up the curve toolbar.
e Shift-select the other composite curve.

3
e Select show point labels. Gz_)

5 6
Each drive rail must have the same direction and

/\
4 number of points. The section curve will be scaled

8
5 9
2 in relation to the distance between the start and end
S points and corresponding points on the two drive
rails.
\10
1

N
6 L> X

e Select the top curve (10 points). )

e From the curve toolbar, select Create a point. <
Distance from paint workplane intersection The Insert pOint into curve form appears. For
Parariete Valle Through nearest point this example the Parameter Value tab is used.

This enables the user to insert a point positioned
at a proportional distance between 2 existing ones.
Enter valus between 1 and 10 5.5 For instance 5.5 is half way between points 5 & 6.

Apply H Dismiss H Help l
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e Select the parameter tab and enter 5.5 and press Apply and then
Dismiss.

When adding each point, the curve is
renumbered and it is therefore easier to add
points from the last number backwards.

Select the bottom curve (6 points).
S -
Select Reverse curve o then Create a point 7
Select the parameter tab and enter 4.5 and press Apply.
Enter 3.5 and press Apply.
Enter 4.5 and press Apply.
Enter 3.5 and press Apply.
Enter 2.5 and press Apply and then Dismiss. Select both curves.

Each curve has the same number of points so
when the surface is generated it will align
smoothly.

e Select all of the composite curves.
d) select the surface wizard. &
x|

e From the surface menu

/ Automatic-Surfacing

Surface Type —Method
% Powersurfacels)

= URBS

~ Options

This time the wizard recognises that a Two
Rails surface is the best choice for surface
creation.

¥ automatic Previewing

= Tangent to Surface(s)

CompCurve Creakor | < ||Tw0 Rails j = |

Preview Apply | (o] 4 | Cancel | Advancedl Help |
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The preview of the surface should appear as
in the picture to the left.

Note: The section height has scaled in
proportion to the distance between the drive
curves at each section position.

e Select the Advanced button from the bottom right of the form.

@\ Options for, Surface from section and two rails

Selection Mode
x (%) Section
3¢ Orrive Rais

COrient Options
(I Planar (%) Biplanar ) aial

|:| Maintain End Tangent Directions

[ Preview ][ Apply ][ O ][ Cancel ][ Help ]

e Select OK.
e Select and Delete the surface.

This form provides the user with more control
over the way in which the surface is defined
from the selected wireframes.

e Tick the option Maintain Depth and
Preview again.

This time the height has been maintained to
that of the original section.
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Editing Surfaces

Surfaces can be edited in many ways. A whole surface or any part of it may be modified
using the edit toolbar. The following example will illustrate some of the main techniques.

Adding Laterals and Longitudinals
The points on laterals or longitudinals control the surface shape. It is often necessary to add
extra curves into a surface to give control at a particular place.

Create a workplane at 0

Create a cylinder at 0, along the Z axis, radius 30, length 100
Convert the surface

Switch on the Surface Orientation Marker in the Options form by
selecting Tools=» Options and under Objects select Surfaces

o Surfaces
\Sl:i:ct ¥ Trimming

Arcs ¥ Diraw surface orismtation mark,

Curves ™ Display nomals for multiple surfaces
Composite curves
Huoles

Lines

Default Diraft Angle

Longitudinal Detail Lines per Fatch

Lateral Detail Lines per Patch

Default Fillet B adius

il

The surface orientation marker always lies on lateral 1 near to point 1. This line shows the
direction the longitudinals flow along. In this case lateral 1 is the circle at the base of the
cylinder, lateral 2 is at the top.

Extra laterals will now be added into the cylinder.

e Select the surface to raise the Surface Edits Toolbar
«B I BXD | BOEIRS

e Select the Add Curve icon 4
¢ In the form, select Lateral and enter the Parameter Value of 1.25
e Apply the form

; _<_\? ) N .Y —_f ¥

o Ly 1 N

4 2 4 4 rl
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@1 Add surface curves M
Digtance from curve I YWiorkplane intersection
Farameter V/alue | Through nearest point
Inizert lateral -
/—'_7—'_\‘\\-\
I J L1 =~
Enter value between 1 and 2 1.2
/r_—'_‘;_‘_\
&%p
Apply Dligmizs | Help |

A new lateral has been created one quarter of the way between lateral one and lateral 2

e Select the Workplane Intersection tab on the form
e Select lateral and enter an offset of 70
e Apply the form

@1 Add surface curves | x|
Parameter 'falue I Through nearest point |
Diigtance from cure Whorkplane interzection ]
/—ﬂ—_—‘“\_\_‘_‘\
[nzert I lateral j L1 Y

Dffzet from current workplane IF"EI

Apply I Digmizs | Help |

\_//

A new lateral has been created at 70mm along the active axis (Z) of the workplane.

Longitudinals are entered in the same way, the Insert option on the form is just changed from
Lateral to Longitudinal.

The laterals will now be changed to give the cylinder a new shape
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e Dismiss the Add curve form

o0

e Select the select curve icon P

Surface |1 j
Laterals Longitudinalz ] ] .
; ; This brings up the Select Curve Form with all of the
_ 2 laterals and longitudinals listed for the selected surface.
3 3
4 4
e Select Lateral 2 as shown and dismiss the
form
| Select Spite Curves can also be selected by picking with the cursor
k. Help
. N |
e From the General Edits menu 4, select Edit selected sub Items as

shown.

I[D

When this icon is selected, only the part of the surface that is selected will be modified, i.e.
lateral, longitudinal or point. If it is not switched on, the whole surface will be modified.

e Select the Scale icon Ei:j and then non-uniform.
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The Lateral has been scaled in X and Y but the Z position has not changed

Select the Lateral 3 by picking it (left mouse).

)

Apply the Edit selected sub items as before ==

Select the Offset Object icon @

Distance (.5 l} -

Enter an Offset Distance of —5.

The Lateral is offset by 5mm inwards giving this
shape. The direction of the positive offset is
indicated by an arrow on the lateral when you first
pick the Offset icon
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e Select the Lateral 4 (Top)
vy
e Apply the Edit selected sub items as before " %=

e Select the Scale icon Ei:j and expand the section by 80/60 in X, 70/60 in

Note how the shape of the lateral has been changed

3
Selecting Turn points Label ON/OFF GZ) will show points number on the selected
lateral/longitudinal.

e Select Lateral 4
e Pick point 1
Ay

e Apply the Edit selected sub items as before '

Any edits applied now will only be applied to this single point, it will now be moved by X -5

Points can be dragged manually or
from inputted values.

Values will be entered in this case.

Issue Designer 7 4.25



4. Surface Modelling Delcam Designer

Enter =5 in the command window
Pick point 3
Enter =5 0 10 in the command window

View along the Y @ axis to see the changes

Iso 1 Eij.and Shaded view 0
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5. Solid Modelling

Introduction

Solid modelling applies a completely different approach in the creation of a CAD model. The
main physical difference is that a Surface model is formed by a hollow, zero thickness skin,
whereas a Solid Model is a mass of material. There main advantages of using Solid
Modelling are the model creation speed and the history tree, in which the user can
reposition or edit operations performed earlier resulting in the automatic update of other
affected items. Delcam Designer is unique in the ability to convert Solids to Surfaces and
vice versa depending on which approach is most suitable at the time. Open Surfaces can be
converted to a Solid, an extremely useful capability which would not be available with a
dedicated Solid Modelling Package.

Boolean Operations
As an Active solid is built up other solids/surfaces can be absorbed into it, which is best
illustrated via the basic Boolean operations ADD, REMOVE and INTERSECT.

Active solid sphere
(Coloured Red)

Selected solid cylinder
(Coloured Yellow)

pie The solid cylinder is joined onto, and becomes part of the Active
A S solid sphere.

L—ELl Removes the selected solid from the active solid.

A hole appears through the active solid sphere caused by the removal of
the solid cylinder, which again is now part of the Active solid sphere.

I__ELl Creates the intersection of the selected solid and the Active solid.

The active solid becomes the common volume of both solids, in this case
producing a solid tube with spherical ends. As before the cylinder is now
part of the original Active solid sphere.

Issue Designer 7 51



5. Solid Modelling Delcam Designer

Basic Solid Model Example

The following example illustrates the creation of a simple
solid model. It emphasises the benefits with the ease of
creation, and the ability to retrospectively make changes to
existing features, causing the remainder of the solid to be
automatically updated to comply.

e Open anew model. %ﬁ
e Create aworkplane at 0 and set the principal plane to Z.
e Select the Solid creation options icon from the main toolbar. e

From the Solids toolbar select Create Solid Block. eA
Centre the base of the solid block about the workplane by typing O.
Press ESC on the keyboard to break out of the command.

Double click on the solid block in the graphics area opening the form
shown below.

e Input the length as 100, width as 50 and height as 50 and press OK.

Dimensions | workspace

Name 1
Length () 100
Width (v} S0
Height (Z) 50
Draft

AV

o o

o

[ ok J[ caneel J[ rep ]

The newly created solid block will automatically become active (red).

e Select the Solid icon from the main toolbar. e

e From the Solids toolbar select Create Solid Clylinder.

¢ In the coordinate input window to the bottom right of the graphics area
input the values 0 0 —20 to position the base of the solid cylinder.

e Press ESC on the keyboard to break out of the command.

e Double click on the solid cylinder in the graphics area opening the form
shown below.

i Cylinder (%] <

Dimensions | workspace

Mame 2

Radius (10

Length 20 =q e X

[ OF ] [ Cancel ] [ Help ] A |\,

e Right click on the solid block and from the local menu select Active.
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¢ With the left mouse, select the solid cylinder and from the
main toolbar select the Feature option. @

The Feature icon is next along from the solid creation icon in the main toolbar. It contains
options for performing constructional operations on the initially created active solid.

¢ Inthe Feature toolbar select the Boolean option, Remove the L—ELl
selected solid ... to create the solid cylinder as a hole through the
active solid block.

¢ Inthe Feature toolbar select the Create solid fillet option. ©
¢ In the form input Radius 5 and with the shift key held down multi-select
(left mouse key) the vertical edges of the solid block before selecting

Apply.

Radius B
el Gt @ Add Adjacent Continuous Surfaces
[CIFilet & Face 7
] add all Continuaus Surfaces
[CIFilet Away From A Face
Y X

All 4 vertical edges will now have a Radius 5
fillet.
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e Select File - Save As and store the model to the following location:-
D:\users\training\COURSEWORK\Delcam Designer-Jobs

e Name file as SolidBlockExample, Press Save.

Solid History Tree

As an active solid evolves it absorbs other solids/surfaces/symbols. All these items are
added to a history tree located on a dedicated explorer window that appears to the left of the
graphics area (if it is not there double left click on the active solid). The last operation to be
performed appears at the top of the history tree. These items/operations stored in the history
tree can be modified retrospectively resulting in an automated update of the active solid
(provided the changes are physically possible). It is also possible to defer the update if
required to allow a series of changes to be implemented at the same time.

e If the history tree is not already displayed open it by double left clicking on
the actiive solid.

% Asolid can be made Active or deactived by left clicking on
- e b the flag (Red flag = Active).
g ;1 If sub-items are not displayed click the [*/ open the sub-
£ 7 directory. To switch off the display of sub-items click on the =!
= 2 . . . : : :
s As is clear from the illustration the first action; create solid
Q s block operation is at the bottom of the history tree whereas
the final solid fillet operation is at the top.

e Double click on the solid fillet at the top of the history tree.

el
g Radius
‘} s [ variable [ Advanced Yariable Editing ]
H Z ( Fillsk Path Editing |
e ¢ e

A box appears around the selected sub-item in the history tree and the Edit Solid Fillet form
opens.

e Input a new Radius 10 and click the OK tab.

The selected Radius in the on the solid is changed to 10 and the
affected area of the solid model automatically re-trimmed to suit.

Note: It is also possible to select solid, sub-items using a double
left mouse click directly on the solid in the graphics area.
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As well as the ablility to modify the original parameters used in the creation of a sub-solid, it
is also possible to apply the General Edits options to preceding Boolean operations.

e Select the cylinder, sub-solid with a single mouse click and identify where
it is located (boxed) in the history tree.

If a sub-solid is selected it changes to a different colour from
the main solid (this also applies if a wireframe view is
displayed). The sub solid is also identified by being enclosed by
a box in the history tree.

= pell = pel
,/E 13 ...... ,/D 15
,/E 11 ...... \/Dll
,/Eg ------ JDQ
v B 7 o B 7
SR s [ =+ [Pl

. QE """" A\

) G e -

Shift - Select the boolean Remove operation in the history tree such that
both the solid cylinder and the Remove operation are selected (boxed).
Select the General Edits options followed by Edit Sub Item (if not already

active). @
ee e

Set X as the operational axis. |@| LR

Select the Rotate object option, entering values in the form to Keep
original, with No of Copies 1, Reposition rotation axis as 0 0 25, and
Angle 90 before pressing Return.

|E|ND of Copies 1 v fAngle 50 v E

The original sub-solid cylinder has been copied and
rotated within the active solid. The new sub-solid
cylinder appears at the top of the history tree.

= el

Q[

e Select File — Save to update the content of the stored model file.

Issue Designer 7 55



5. Solid Modelling Delcam Designer

e Close the model.

Die Example
The following Die example shows the application of solids to produce complex parts quickly
and easily.

e Open anew model. %ﬁ
e Create aworkplane at 0 and set the principal plane to Z.

e Select the Solid icon from the top toolbar. e

e From the Solids toolbar select Create Solid Block. ‘aa
e Position the block by typing 0 0 —40.

e Select 3 4| to break out of the command.
e Double click on the solid block in the graphics area opening the form
shown below.

Dimensions | Workspace |

Mame I 1]
Lergth ) 100 .
: e Setthe length as 100, width as 150 and

M > height as 40 and press OK

Height (2} I"fD .

K | Cancel | Help |

= x|
S=F

PowerSHAPE also displays a History tree of all the
solid operations. The red flag indicates that the solid called 1 e W
is the Active solid. \, e e
The first solid automatically becomes Active and is shown in \ /

Red or Black.

e Setthe principal plane to X.

e From the pop up under Solid Block select create solid cylinder. a
e Position the cylinder with the co-ordinates: -55 0 0.
e Change the radius to 2 and the length to 20.
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Further solids are shown in Grey, as only one solid
can be Active at any time.

e Create a solid cone with the co-ordinates: -35 0 0. 9
e Change the top radius to 1, base radius to 2 and length to 30.

This model contains one active and 2 non-active
solids. These non-active solids need to be joined
together to generate a new solid.

= |

e 1
D 2
The feature tree now contains 3 solids. The active solid oW 3

has a flying red flag to indicate that it is active.

e Select the solid cylinder and Right click over it to bring up the sub-menu
and select Active.
e Select the solid cone.

e From the Features menu, @ select Add the Selected Solid to the

Active Solid. L_ELl

The cylinder and cone will be automatically joined together as a new active solid.

e
- @ 2 In the history tree, the second solid has become the active one and it
- H 3 shows that solid cone has been added to the solid cylinder. This solid
W 7 can be removed from the active solid by clicking on the tick. The
D+ solid can be added in again by selecting the cross.

The component to go into the die will be imported as surfaces and then turned into a solid.
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e Blank all of the solids and import the model handle.dgk from
D:\users\training\Delcam Designer data

The model is made up of various surfaces, which will be
turned into a single solid.

e Select all surfaces.

= %
e From the Solids toolbar select Solid from Surfaces.
e Select Unblank.(Ctrl + L).

e 1
- @ 2 The surfaces have become one single solid. If the surfaces do not match
- M = a watertight wizard will appear to fix any gaps.
>
P a A copy of this solid should be made for later use.
Fo®h o

This new solid can now be added to the original solids.

e With the ‘gate' solid Active, select the handle solid.

e From the Features toolbar ‘@ select Add the Selected Solid to the

Active Solid. L_ELl

To produce the cavity in the die block, this final
solid can be subtracted from the die block. .

e Make the block solid active and select the Handle & Gate Solid.
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e From the Features toolbar ‘ % select Remove the selected Solid
from the Active Solid. @

e Close the Model without Saving.
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6. Three Stone Ring

Ring Design

-
)" ] The object of this exercise is to design the
Ring seen here.

We will be creating the design using a
mixture of ArtCAM JewelSmith and Delcam
Designer functionality.

=

e Open ArtCAM JewelSmith

ok

. % Create New Project
e Select the Create New Project button.

5 [Urtitled)

S Azzembly

e Select Models from the Project Tree.

e Select the Blank - 3-axis >

i 3-Axis Shank Bg

Show Help 7| x|

¢ In the File Name area type in PS-Designer
Ring with British Size O, Width 2, Border
5, Thickness 2 and Resolution 40. ¢ ] Standarg: - [Brit=h [
Size: IO j
Diameter: |17 5 i

@ Width: |2 FrIm
e Select the Accept button. Border. |5 mm

L Mame: |Three Stane Ring

Thickness: mrm

|2
Resnlutinn:|4ﬂ pixmm
O @
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e Make a copy of the inner ring vector. (Ctrl + C, Ctrl + V)

e Make sure the inner ring vector is selected and press N on the keyboard to
enter Node Editing.

Position the cursor over this node and press the C
button on the keyboard to Cut the vector.

Repeat the procedure for the bottom opposite
node.

This will have cut the ring vector into two equal
halves.

e Delete the left of the two vectors.

e Press the Esc key on the keyboard to exit Node Editing.

Drag down a horizontal guide line and position it at
Y 14.

Drag across a vertical guide line and position it at
X 3.5.

We will use the intersection of these two guide lines
to help create the ring profile.

e Select the half vector created earlier and press N to enter Node Editing.

e Drag the top node to the intersection of the two
guide lines as seen here.
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Right mouse click over this node and select
Properties.

Change the X Coordinate to 0 and the Y
Coordinate to 8.

Select OK on the form.

The vector should look something like this.

We now need to move this node to complete the
shape required.

¢ Right mouse click over this node and select Properties.
e Change the X Coordinate to 9 and the Y Coordinate to 7.5.

e Select OK on the form.

e The vector should look something like this.

¢ Make any minor adjustments of your own choice to the
nodes if you so desire.

e \We now need to mirror this vector to the left to create
the other half.

e Press the Select s 4 button to exit Node Editing.

Issue Designer 7 6.3



6. Three Stone Ring Delcam Designer

e The new vector should still be selected so click on the Mirror é!
Vectors button in the Vector Tools area of the Assistant page. ¢

Mirror Types

== Vertical | Horizontal @ Select Left to create a new copy of the original
T R «  vector.

R Centre F%: Centre

B gt R o e Close the form.

Both of the two new vectors need to be joined together as one.

e Hold the Shift key down and select both new vectors.

P

e Click on the Join Vectors with a line button. ™~

This has now completed the design of the ring profile that will be used in Delcam Designer.

We now have to create the cross section vectors that will be used in conjunction with the ring
profile vector to create the main ring shape.

e Create a Circle of diameter 2mm.

e Create an Elipse with Width
4.5mm and Height 2mm.

e Holding down the Shift key
select the three vectors created.

e Press (Ctrl + C) to copy these
vectors to the clipboard.

e Open Delcam Designer, right click in model space and select Paste from
the menu.
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The vectors from ArtCAM are pasted in flat down in Z and the X 0 Y 0 position remains at
the centre of the ring profile here.

The vectors are yellow in colour, which means that they are selected.

e Click away from the vectors to deselect them and they are now white in
colour.

N.B. Most items when selected in Delcam Designer are yellow.
The next part of the exercise is to position, rotate and move the vectors into the correct

orientation to allow the main shank surface to be created.

e Select the Workplane icon on the top IL» toolbar.

e Type 0 in the command window at the
bottom of the screen.

Tol 001 0]

e Pressreturn on the keyboard.

Z/\ This new Workplane will become the
R A e main datum for the ring design.
o
e Click away from the Workplane
~ and you will see it has turned
= red.
B

This indicates that it is the Active Workplane and hence X 0, YO and Z 0.

More Workplanes can be created in different areas and orientations on a model to make it
easier to create objects such as wireframe around it.

Each time a new Workplane is created it becomes Active and also the new X 0, YO and Z0
position.

Workplanes can be positioned by using the mouse onto keypoints, intersections etc. or by
typed position input in the command window.

Now that the Workplane has been created we can rotate the ring profile vector into position.
e Select the ring profile vector.

N
e Select the Show general edits options button on the right toolbar. W,
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e We need to Rotate the curve by 90 degrees firstly around the X axis then
around the Z.

e Click on the use the YZ ‘face’ of the Workplane button on the bottom

toolbar. %

This sets the rotation axis as X.

e Click on the Rotate Object button on the left toolbar. @

e [
D 95 2 “ %] The blue arrow here indicates the current rotation axis. In
this case the X.
Z
¥ f x e Typein 90 in the Angle box and press return
N

on the keyboard.

¢ Do not close the form yet.

We now need to rotate the curve around the Z axis.

e Click on the use the XY ‘face’ of the Workplane button on the bottom

toolbar. %

= e ==| The blue arrow points upwards indicating the current
rotation axis is now Z.

e Typein 90 in the Angle box and press return
%2 on the keyboard.

e Close the Rotate form.

2
. The ring profile curve is now in the correct orientation as it would be
= X in ArtCAM JewelSmith.

We will now start to position the circle and elliptical cross sections.
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e Click away from the curve to deselect it.

e Select the 2mm diameter circle that we pasted in
earlier.

e Select the Move/Copy Object button from the left hand %
toolbar. .

The “‘move from’ indicator appears on the circle here.

e Position the mouse cursor at the Key-point
T’ at the bottom of the ring profile curve.
,R'E"x

e Click the left mouse button to position the

2mm circle.
Key-point

prp—
-

The circle moves to the key-point but remains in the
wrong orientation.

We need to rotate it 90 degrees around this point and in

o
/the X axis.

o]

e Click on the use the YZ ‘face’ of the Workplane button on the bottom D
toolbar.

¢ Click on the Rotate Object button on the left toolbar. @

e Grab the rotation axis arrow Key-point
with the left mouse button
and drag it to the key-poimt—e__
at the bottom of the ring @
profile curve.
e Click the left mouse button
to position it.
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e Type in 90 in the Angle box and press return on the keyboard.

e Close the Rotate form. @

e Select the elipse curve with the left mouse button being
careful not to select one of the blue node points.

Drag the elipse to the key-point shown
here.

e Click the left mouse button to position
it.

e Select Yes to the Confirm Drag by box.

e With the elipse still selected, click on the Mirror/symmetrise object button

on the left toolbar. %

Click the ZX button to create a new
elipse on the opposite side.

We will now create two further elipses up and around the ring profile curve.

e With the second elipse still selected click on the Rotate G
object button on the left toolbar.

The blue arrow should still indicate that
we are still working in the YZ.

o Click on the Keep original
: button on the left of the form
and type 45 in the Angle box.
e Press return on the keyboard.
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. A new copy of the elipse is positioned around the ring
z > profile curve.

X
J We will now mirror this to create one on the opposite
side.

e With the elipse still selected, click on the Mirror/symmetrise object button

on the left toolbar. Eﬂi‘l

\. Click the ZX button to create a

J new elipse on the opposite side.
X

e Close the Mirror form.

\To finish off the cross section construction we need to place
@Jy ;

*

two 5mm diameter circles on the ends of the profile curve and
at the same time be aligned to the geometry.

We can do this by creating a Workplane Aligned to Geometry.

e Click on the use the XY ‘face’ of the Workplane button on the bottom
toolbar. @
e Select the Workplane icon on the top toolbar. L

e Select the Single Workplane aligned to geometry button on ’EI
the left toolbar.

ey-point
%ZL/ e Position the Workplane on the key-point seen

here.

@; e Click the left mouse button to position it.
X
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Select the Arc button on the top toolbar. O

Select the Create a full arc (circle) button on the left toolbar. @

Type 0 in the command window at the
bottom of the screen.

Tol 001 0]

Press return on the keyboard.

Press [% 4

to exit circle creation mode.

& Arc

Marme
Radius

Span angle

i

..4

2.5

380

Double click the new
circle with the left mouse

cowemaktpe oo g e ] button to open the Arc
Workspace ‘.Workpl‘_ane_ v N\ fo rm.
Centre 0 o] 0 _ Z
Through ERRIC 1B Enter a Radius of 2.5

QK

J

Cancel ] [

Help

]

then click OK.

| | | @
Select the Show general edits options button on the right W,
toolbar.
With the circle still selected click on the Move/Copy Object %
button from the left hand toolbar. i
In the bottom command window type in 001 | 25
2.5 then hit return on the keyboard.
Close the Move/Copy Object form.

: A

At the bottom left corner of the screen select 1 fro 2 2
the Workplane list. ; ":[

This will deactivate the second Workplane and activate our first Workplane in the centre on
the ring profile.

6.10
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R
e Select the Show general edits options button on the right toolbar. )

e With the 5mm circle still selected, click on the o
Mirror/symmetrise object button on the left toolbar.

¥ ¢ Click the ZX button to create a
new 5mm circle on the opposite

side.
z
!T "
. @%ﬁ e Close the Mirror El
form.

e Our wireframe for the ring shank has now been created.

e Drag a window around all of the curves in the model. They will all turn
yellow.

9

e Select the Surface button on the top toolbar.

[ CompCurve Creator ] |Drive—Curve v |

Optiors

Automatic Previewing

Tangent to Surface(s)

[ Preview ] [ Apphy H QK ] [ Cancel HAdvanced ] [ Help ]

A new surface is automatically created based on the curves we have made earlier.

e Click on the Apply button.
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e The Automatic — Surfacing form can stay open at this stage so we can
continue to create the surfaces to fill in the ends of the design.

& Automatic-Surfacing

Surface Type

Options
Automatic Previewing

Tangent to Surface(s)

[ CompCurve Creator I

FiFn <

[ Preview ] [ Apply I[ QK

] [ Cancel ][Advamced ] [ Help ]

e Click on the Apply button.

1 Automatic-Surfacing
Surface Type
(3) PowerSLrface(s)

()NURBS

Cptions
Automatic Previewing

Tangent to Surface(s)

Method

Tv_[

= /
f).

I CompCurve Creator ]

< |FromNetwork v‘ =

[ Preview I [ Apply H K

] I Cancel HAdvaﬁced ] [ Help I

)

e Click on Apply then OK to close the form.

Click on this 5mm
diameter circle to
see it
automatically
create a fill in
surface.

Click on the
remaining 5mm
diameter circle to
create the second
fill in surface.

e The main design of the shank is almost complete. Next we will create the
setting area for the stones.

e Because Delcam Designer is a hybrid surface and solid modeller we will
convert these three surfaces into one solid, hence speeding up the process
to create cavities etc using Boolean functionality within the solid options.

e Drag a window around the whole model to
select all items.

When selected they should look like this.

6.12
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o
e Click on the Solid button on the top toolbar.

e Click on the Create solid from selected surfaces button on the h‘i’j%
left toolbar.

The three surfaces have now become one solid, hence the indication
by change in colour. Grey represents a solid.

e Deselect all items by left clicking anywhere in model space away from the
design.

Select the right hand 5mm diameter
circle by clicking on it then accepting
the choice from the Choose form.

e Click on the Create one or more solid extrusions button, on the ‘ w
left toolbar. &

The extrusion is created but needs to be adjusted to the
correct length.

There are two ways you can do this.

One is to drag the blue arrow down until you can see the
correct value appear.

Two is to double click the extrusion with the left mouse
button to open the Extrusion form.
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We will use option 2 in this case.

e Double click the extrusion with the left mouse button to open the Extrusion

form.

DIMensons | Workspace | Sketeh |
Name 2
Length 05
Draft Angle 0
Megative Length 0

[JEqual lengths

e Change the Length to 0.5

e Select OK.

I OK ] [ Cancel l ’ Help

Solid Extrusion 2 (General)

Cut
Copy

1 -
Delete
.
A Mext Selection

h Clear Selection
Select Al

Y Blark
Blank Except

Undo

Selection Information

Corvert
Copy All Surfaces
Modify...

Reverse

The extrusion is now the correct length but requires a fillet to be
added to the top edge.

For the Solid Fillet functionality to work we need to make the
extrusion the Active solid.

e To do this, simply right click over the extrusion and
select Active from the menu.

A tick will appear next to the word Active to indicate whether
Active or not.

N.B. For other Solid Boolean functionality to succeed, such as
Solid Addition and Subtract you need to have one active solid
(not selected) and at least one inactive solid (selected).

e Select the Feature button on the top toolbar. @

e Select the Create solid fillet button on the left toolbar. Q

6.14
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& Fillet

e Typein 0.49
in the Radius
box then
select the top
edge of the
extrusion as
seen here.

e Apply and Dismiss the form.

The fillet is successfully created.

We now need to create the cavity for the setting.

To do this, first we need to create a Workplane that sits on the top of the extrusion and
perpendicular to the top face.

The easiest way to do this is to create a piece of wireframe that the Workplane can be aligned
to.

O

e Select the Create an arc through three points button on the left toolbar.

e Select the Arc button on the top toolbar.

For the first point click this Key-point here.
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Click on the second Key-Point here.

Finally click on the third Key-Point here.

Radius ¢ Round up the Radius value to 2mm then click on
i ‘ 2 ‘ [ Mext Solution ] OK.

e e e Double click the 4mm
- 00 | ; ;
e e diameter circle to open the
T Arc form.
Workepace Werkplne v - ~
Cake [-000m1z5 | [-s912304 | [13.1me7e | (B e Click on Full to make the
Trrougn [-1sm42e3 | 685758 | [1261957¢ | [ ’
circle complete.
o I o )

e Click on OK to close the form.

e Select the Workplane icon on the top k» toolbar.

e Click on the Single Workplane at centre of selection button on
the left toolbar. @

The Workplane still appears at an angle to the top face.
This is because it is still relative to the original Workplane
1 in the centre of the shank.
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We will use the yellow handle bars to drag around the X and snap to the top face.

Position the mouse cursor over the yellow
handle bars here.

The intelligent cursor hand will appear.

Holding down the left mouse button
move the grab hand to the Key-Point
shown here then let the mouse button

go.

The Workplane should now be aligned and
perpendicular to the top face.

~ To check this you can view the model in X and Y
individually to see.

e View from left (X-).

e Select the Diameter 4mm circle on the top face created earlier.

e Change the Diameter to 3.8mm (Radius 1.9mm).

e Select the Feature button on the top toolbar. a
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e Select the Solid Cut button on the left toolbar. E;

& Solid Cut

Type ; ;

o o e Typein 0.5 in the Depth
box.

wge p (@

[(reverse [ ] SeleCt OK-

[ Extrude both directions

Sketch

The cavity should look like this.

We will copy this design to the opposite side.

Ml

e At the bottom left corner of the screen select 1 fro 2 (

i —|World -

the Workplane list. L g 1t

@)

e Select the Show general edits options button on the right *
toolbar.

e With the top design still selected, click on the Mirror/symmetrise w
object button on the left toolbar.

Mirror

lozeze

- o Click the ZX button to create a new design
on the opposite side.
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e At the bottom left corner of the screen select 3 from the ’

Workplane list.

>
e Click on the Solid button on the top toolbar.

e Select the Create solid cone from the pull out menu on the left toolbar.

Dimensions |Wg[kspace|
Marme I-I 5
Top Radiuz I'I
Basge Radius IP
Length I2

Ok | Cancel | Help |

e Click the Workspace tab.

Dimensions | Workspace

Workspace WWorkplane

[ o4 H Cancel H Help

To position the Solid Cone, type 00 -0.5in
the command window then press return.

Double click the cone
to open the Cone
form.

Make the Top Radius
1, Base Radius 2 and
Length 2.

This form allows you to position and rotate the cone

when needed.

. e Click on the Twist X button here.

The calculator will appear allowing you to type in the required angle.

Issue Designer 7
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In this instance we need to type in 180 then click OK.

Select OK on the Cone form to close it.

Ml

At the bottom left corner of the screen select 1 fro 2 I
the Workplane list. —— kel '
p &, E w» |
Select the Show general edits options button on the right 20
toolbar. \ﬁ,‘

With the cone still selected, click on the
Mirror/symmetrise object button on the left toolbar. %

e Click on the ZX button to
create a new copy of the
cone on the opposite side.

To create the cavities we need to remove the two Solid Cones from the main Shank solid.

First we need to make the main Shank solid Active.

Right click over the main shank solid and select Active from the list.

Select either one of the two cones.

.
e
Select the Feature button on the top toolbar. =

Select the Remove the selected solid, surface or symbol from the active

solid button on the left toolbar. @

The cone is removed to leave the cavity.
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e Repeat the procedure to
complete the opposite
side.

e Click on the Solid button on the top @ toolbar.

e Select the Create solid torus button from the left toolbar. @

¢ In the command window at the bottom of the screen, type 0 0 13 to position
the torus.

e Double click the torus to open the torus form.

-
&1 Torus

e Fill in the values
shown then click
on OK.

a?hl

e Select the Show general edits options button on the right
toolbar.

e Select the Scale the object(s) button on the left toolbar. ‘E@

e Click on the reposition scale origin button on the Scale @ form.

——e« Click on the Key-Point at the centre
. ofthe Torus.
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e Click onthe Lock X and Lock Y
buttons.

By locking the X and Y we have only scaled the Torus in Z
leaving the major diameter as it was.

¢ Right click over the solid torus and make it Active.

e Select the Arc button on the top toolbar. O
e Select the Create a full arc (circle) button on the left G)
toolbar.

¢ In the command window at the bottom of the screen, type r 2.4 and then
press return to size the circle.

¢ Inthe command window at the bottom
of the screen, type 0 0 13.5 then press
return to position the circle

L
Click on the Solid button on the top toolbar.

Click on the Create one or more solid extrusions button on the ‘ ﬁ
left toolbar. A

e Adjust the extrusion length so that it
clears the top of the torus similar to
that seen here.
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Select the Feature button on the top

the active solid button on the left toolbar.

>

Top Radius
Base Radiuzs
[ QK ] [ Cancel ] [ Help ]

e Click the Workspace tab.

Dimensions | Workspace

WWorkplans

Workspace

[0 IE

[ [ol'¢ H Cancel H Help

]

setting.

o
Click on the Solid button on the top toolbar.

toolbar.

Select the Remove the selected solid, surface or symbol from @ |

The extrusion is removed to give the seat for the

Select the Create solid cone from the pull out menu on the left toolbar.

In the command window at the bottom of the screen, type 0 0 13.5 to
position the cone.

Make the Top Radius
1, the Base Radius 2
and Length 2.

This form allows you to position and rotate the cone

when needed.

_ e Click on the Twist X button here.
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The calculator will appear allowing you to type in the required angle.
¢ In this instance we need to type in 180 then click OK.
e Select the Feature button on the top toolbar. @

e Select the Remove the selected solid, surface or symbol from @ ‘
the active solid button on the left toolbar.

The cone is removed to give more clearance for the gem.

e Click on the Save selected model button on the top E
toolbar.

&Y Save Model As

Model Mame | PS-Designer 3 Stone Iy |

Description | |

Fasswiord | |

Store Outside Database ] I Save ] I Cancel ] [ Help l

e Search Location D:\users\Training\Coursework\Delcam Designer Jobs

e Type in a name as 3 stone ring.psmodel then Save

To finish the design we need to add some diamonds. One for the centre setting, and two for
the outer settings.

e In an ArtCAM JewelSmith Project select the Add Gem @ button in the
Assembly Manager area.

e Select a Round gem. gg,
Round
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@Standard: Custom -

Size: ’ﬁ
b e . Eill in the form with the values seen
Width: 48 ere.
Depth: 2 e Click the Forward arrow.
o O+

e Choose a Diamond colour. o

@) add Gem

Gem MName: Centre Gem

e Type in the name Centre Gem, then
click the forward button.

Q

e The centre gem is created and ready to be exported for use in Delcam
Designer.

e Repeat the above procedure to create one more diamond with Custom
sizes of Length 4, Width 4 and Depth 1.7.

e Name this diamond Side Gem.

E|---;_,'__J Azzembly
In the JewelSmith Assembly tree you should see the two created %" Centre Giem

gems. o 43? gide gem
e Click on the Centre Gem name.
¢ Right mouse click and select Export Gem.

¢ In File name type centre gem and Save as type select Wavefront Object
Files (*.obj).

File narmne: Icentre ger ﬂ Save I
Saveastype:  [wavefont Object Files [*.abj) =] Cancel |

e Save in Location D:\users\Training\Coursework\Delcam Designer Jobs

e Click on Save.
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e Repeat this procedure for the Side Gem giving the name side gem in the
File name area.

e Return to the Delcam Designer window

e From the top left corner select File > Import.

@ Select A File To Import

Look in: ‘Q PS-Designer Training Example B ‘ 2@ E

(25hank
e centre gem.obj

e ipggzs?;ﬁ“;ﬁ;g,ﬁ,ﬂg — e Browse to the location of
— s!de gem.ob]
@ [ side gem obij.mt the gemS.

Deskiop &8 size o profie vector.eps

e Select centre gem.obj

My Documents

from the list
PL
My Computer
e Select Open.
e — S
1le name: I:enre Eem.o pEﬂ

Files oftype [** (Al Files) v [ concel |

e The gem gets imported and angled to the current
active Workplane.

e Select the gem with the left mouse button.
e Select the Show general edits options button on the right fﬁ

toolbar.

e Select the Move/Copy Object button from the left hand %
toolbar.

6.26 Issue Designer 7



Delcam Designer 6. Three Stone Ring

¢ In the command window at the bottom
of the screen type in 0 0 13.9 then
press the return key.

Tol 001 00132

The gem is positioned correctly.

| You can change its position to suit yourself by adjusting the 13.9
Z value if required.

e At the bottom left corner of the screen select 3 from
the Workplane list.

e From the top left corner select File > Import.

e Select side gem.obj then Open.

The side gem gets imported and angled relative to the new active
Workplane.

e Select the gem with the left mouse button.

e Select the Show general edits options button on the right Eﬁﬁ

toolbar.
e Select the Move/Copy Object button from the left hand %
toolbar. .

e The move origin of the gem
"2./ should be here at the gem
centre.
e If not, use the reposition move
origin button and click at this
point.

[l Mo of Coples| 1
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e Position the cursor at the active Workplane
Key-Point and click the left mouse button.

The gem appears to be slightly too high.

¢ Inthe command window type 0 0 -0.2then 14 001  00-0.2
hit return.

e The side gem is adjusted correctly.

e Close the Move form.

¢ We will now make a copy of the side gem to the opposite side.

e At the bottom left corner of the screen select 1 fro = B I
the Workplane list. E*gorld _[

e Select the side gem.

N | X
e Select the Show general edits options button on the right W,
toolbar.
¢ With the cone still selected, click on the Mirror/symmetrise m

object button on the left toolbar.
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e Click on the ZX button to create a new
copy on the opposite side as seen here.

The design is almost complete.

e Select the Save button on the top toolbar. E
We will now create a rendered image that can be used to email to prospective customers.

First we need to change the material properties of the shank and settings to 18ct Gold.

e From the left toolbar click on the Quick select all solids button.
N OB S AEE

e This should highlight all the solids in the current model.

Iw! Tools  Macro

;!: Style Dasthed
{  Style Solid
Lewels...

e At the top of the screen select Format then Materials.

Transparency 4
Lights...
Labels. ..

&1 Material Selection

Material Type Defaults v | [Juse wireframe Colour
Material for W Use Insice Colour e Select Metal from the
Layolt... E gg:ttgjjeﬁétal @ Calete p u I I d own I | St .
Materials ap;?E)ITeErosion
Wiood

| | 0y >l ] e

e Select Gold 18ct button.

Jold 18ct
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e Select OK to close the form.

The solids have changed colour and now we are ready to create
a rendered image.

e Select the Restore down button on the top right hand corner of the screen.

& PS-Designer Ring Design for training

e Adjust the model window
smaller to allow faster
rendering.

e Also rotate the design into the
desired position, similar to that

seen here.
e Select the @ @ Raise the render form button from the right
hand toolbar. 8 P
Lights
S e Inthe Lights area of the form select
© permee EZ === 377 the Change button.
[ automatic Update
[ Render J [ OK ] [ Cancel ] l Help ]
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& Light Studio Selector

Light Studio Groups e From the pull down list select

Light Studios : Standard.

'O 'Q O h” ~ e From the Light Studios area click on
Standard Stdleft StdRiaht stdCenfre StdToo Sk th e Sky butt on.

e Click on OK to accept the form.
e Click the Render button on the Render form.

There may be a slight delay before rendering starts.

Eventually you will be left with an image such as the one seen on the next page.

e If you are happy with the result select OK on the Render form.

e To save the image select File at the top left of the screen then Print to
File.

e Search Location D:\users\Training\Coursework\Delcam Designer Jobs
e Type in a name as Rendered 3 stone ring.jpg then Save.

=
e Select the Save button on the top toolbar and name model as 3 stone
ring.psmodel in the same location

Issue Designer 7 6.31



6. Three Stone Ring Delcam Designer

6.32 Issue Designer 7



Delcam Designer 7. Tapered Ring

/. Tapered RiIng

Tapered Ring Design

The object of this exercise is to design the
Ring seen here.

We will be creating the design using the
Delcam Designer functionality.

e Create a New Model
e Select the Workplane icon on the top toolbar. L’

e Type 0 in the command window at the

Tol 001 0
bottom of the screen.

e Pressreturn on the keyboard.

HiEZasaE
&Z This new Workplane will become the main
“Y - datum for the ring design.
- b :
e Click away from the Workplane
o = and you will see it has turned red.
e

This indicates that it is the Active Workplane and hence X 0, YO and Z 0.

More Workplanes can be created in different areas and orientations on a model to make it
easier to create objects such as wireframe around it.

Each time a new Workplane is created it becomes Active and also the new X 0, YO0 and Z0
position.
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Workplanes can be positioned by using the mouse onto keypoints, intersections etc. or by
typed position input in the command window.

e Select the View from right (+ x) button from the right hand G:
toolbar.

-

The Workplane will reflect that we are now working in the ZY
plane.

The reason for this is so that the ring is designed in the correct

orientation ready for copy/pasting directly into ArtCAM
¥ JewelSmith for machining later.

O

e Select the Arc button on the top toolbar.

e Select the Create a full arc (circle) button from the left toolbar. @

Z
e Position the circle at the Workplane key-point.
Key-point

¥ e Click the left mouse button to place the circle.

e Modify the circle radius until it has a Radius of
8mm.

(6]

\}

e From the top toolbar select the Line button.
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~

e Select the Single lines button from the left toolbar.

Tangent . :
e Position the line on the cursor at

approximately this point until the word
z “Tangent” appears.

e Click the left mouse button to place the
start of the line.

e Move the mouse to the left until the
intelligent cursor indicates an Angle (A)
of 155 and Length (L) 8 as seen here.

e Click the left mouse button to finish the
line.

\y

e From the top toolbar select the Line button.
e Select the Single lines button from the left toolbar. /

e Click firstly on the Workplane key-point
then secondly on the intersection at the
bottom of the circle.

We will use this line to enable us to trim the circle on the
left side of the Workplane to the tangential line at the top
to the intersection on the vertical line with the circle at the
bottom.

Intersecti
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_ _ _ N
e Click on the Show general edits options button o the left toolbar. W,

.
e Select the Interactively limit wireframes button. X

e We now need to click on the part of the circle we do not want.

z - e Click on this
i part of the
circle to
£ remove it
-7 S I X = )

Press [% 4

to exit the Interactive limit of wireframe.

e Select the vertical line we created earlier.

e Press Delete on the keyboard to delete it. It is
no longer required.

We are now left with the circle and line which form the first
part of the ring design.

y Because they are two separate items we need to connect them
together as one. Once done this will be a composite curve.

1.4 Issue Designer 7



Delcam Designer 7. Tapered Ring

e Holding down the Alt key on the keyboard, click
B on either the line or circle.

The two curves are now joined together to create one composite
curve.

The curve is made up of node points. These points will be moved
to create a twisted effect for the ring design.

e Select the View ISO 1 button on the right toolbar. @

— R

z

e Select the top point with the left mouse button.

Y x  Tomove the point by a given amount, just type in the distance in
the command window at the bottom of the screen.

In this case we want to move the point by 3mm in X+.

e Type 3 in the command window then

001 3
press return on the keyboard.

the command window then press return on the
keyboard to move it 2.5mm in X+.

%if/} e Select the second point and this time type 2.5 in

i " e Select the third point and move it Imm in X+.
S
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e Select the View from Top (Z+) to see the effects. g

{ You will notice that the curve is not smooth running through the
[ﬁ points.

We can improve this by freeing the tangencies through all points along
w2 = X the curve.

—— « Make sure that the curve is selected. Click between
f the curve points so that only the curve and not an
[f individual point is picked.

e Select the Edit Tangent Angles button on the curves toolbar at the top

%
of the screen. L%
&Y Tangent Editor g
Set tangents g .
Tangent |Before and After v & ?g_/ e Click on the
Y Free button.
Mag Before and After v| |11.253 {
Scale Magritude j ‘T See the curve smoothed.
1.0
I QK ] I Cancel ] l Help ]

e Select OK to close the form.

e Select the View from right (+ x) button from the right hand toolbar.

&

F

O

e Select the Arc button on the top toolbar.
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e Select the Create a full arc (circle) button from the left toolbar. @

Z

e Position the circle at the Workplane key-point.

Key-point
v e Click the left mouse button to place the circle.
LR
j? e Modify the circle radius until it has a Radius of 8mm.
Y This will be used as a guide to see if the curve is correct “down the

finger”.

e Viewing the ring design down the x (finger) we
can see that the curve needs re-adjusting in
places to give a more circular shape.

e Select this point on the composite curve.

e Grab this handle with the left mouse button
Magnitude 12.75 then drag and modify the curve until it
matches the 8mm radius circle then let go.

™
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Q\\ e Adjust the curve until you have a similar
e result to this.
=

o

We will now straighten the curve between the top two points using the Edit Tangent Angles
form.

e Select the top point on the curve.

e Select the Edit Tangent Angles button on the curves toolbar at the top

%
of the screen. Li5
e,
Set tangents . [ ] SeleCt the
Tangent Before and After v ' Stralghten
&)
button on the
£ efore and After v g = -
oo e | form to give the
Scale Magrituide j reSU|t ShOWn
10
TK I l Cancel I [ Help ]
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e Select OK to close the form.

e Select the View from Top (Z+). @

/You can see that the curve is not smooth going into this point.

1} I We can free the tangencies once again through this point but first we
have to select it.

e Click on the point to select it then on the Edit Tangent Angles button.

7%
3
Set tangents !
Tangent Before and After v @] ' ) CI|Ck on the Free
)
= button and the
Mag Before and After v :8 ay curve |S SmOOthed
S e
Scale MagnitLide J
1.0
QK ] [ Cancel ] [ Help ]

e Select OK to close the form.

N.B. It is advisable when modifying curves in this way to continually change the view to see
how the curve looks and if required free the tangencies where necessary.

The main “drive curve” for the shank is now complete. We will now create the cross sections
needed to produce the square tapered design.

e Delete the 8mm radius circle used as a guide as we no longer need it.

e Select the View ISO 1 button on the right toolbar. @
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e Select the Use the XY face of the Workplane button at the bottom left

of the screen. %

e Select the Workplane icon on the top toolbar. I"’

z

ﬂg e Position the new Workplane at the key-point
at the bottom of the curve.

We are going to create a rectangle around this Workplane

%/E 2mm X 1.5mm.
y-point

e Select the View from front (Y-) g button.

W

e From the top toolbar select the Line button.

W

e Select the Continuous lines button from the left toolbar.

Fad

e Click on the Workplane key-point to position

Key-point _ _
the start of the continuous lines.

e Move the cursor to
the left of the
1 Workplane until the
value of L:1 appears
SR X then click the left
mouse button.
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P —
e Move the cursor down until you achieve

1.5 a length of 1.5mm then click the left
mouse button.
S

e Move the cursor to the right X+ to a length of 2mm then up to a length of
1.5mm and finally back to the Workplane origin.

e Press [%4

to finish the line creation.

The final rectangle should look like this.

To remove the sharp edges we will fillet the corners with a
0.3mm Radius.

e Holding down the Alt key, click on any of the rectangle lines. This
should create a composite curve.

O

e Select the Arc button on the top toolbar.

-/

e Click on the Create a fillet arc button on the left toolbar.

e Type r 0.3 in the command window

Tol 001  ro3 then press return on the keyboard.

This sets the arc radius before applying.

5 X
- q'? e Hold the mouse cursor over the
composite curve then click the left mouse
button to apply the fillet on all corners.
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é‘f u l:} '.'{
All corners are filleted 0.3mm.

This cross section is complete.

e Press %:

We will now create a 4mm square cross section at the other end of the shank profile curve.

to end the filleting function.

As this end is angled we will create a Workplane that is automatically aligned to the curve
when positioned there.

e Select the View ISO 1 button on the right toolbar. @

e Select the Use the XY face of the Workplane button at the bottom left

of the screen. %jj

b

e Select the Single Workplane aligned to geometry button on the left

&

e Select the Workplane icon on the top toolbar.

toolbar.

Key-
e Position the Workplane at the remaining end
of the shank profile curve.
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The Z of the Workplane is automatically aligned with
the geometry making it easier to design around it and
angled correctly to the curve.

Select the View from Top (Z+). Eﬂ

W

From the top toolbar select the Line button.
Select the Continuous lines button from the left toolbar. W
Type 0 in the command window, then press return.
Type 0 -2 then return.

Type 4 then return.

Type 0 4 then return.

Type -4 then return. Zﬁ\;

Click on the Workplane key-point to finish the e

4mm square. \TLE Sy

Press W

Y

A

to end the Line creation mode.

/ ¢ Holding down the Alt key, click on any of the
lines.

St S S (R

This should create a composite curve.
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O

e Click on the Create a fillet arc button on the left toolbar.

e Select the Arc button on the top toolbar.

-/

e Type r 0.3 in the command window

Tol 001  ro3 then press return on the keyboard.

e This sets the arc radius before applying.

Y

b

e Click on the composite curve to fillet all
@7 = X corners with a 0.3mm radius.

e Press W

We will now create further vectors inside this one for creating the setting area of the stone.

to end the filleting mode.

e With the 4mm square curve selected click on the Show general edits
@
options button o the left toolbar. ™ "

e Click on the Offset object button on the left toolbar. @

e Enter 0.5 in the Distance box
B el 0. 3 and make sure the brown
B arrow points inwards as is

here. Press Return.

¢ If not you can enter a value of — 0.5 in the Distance box then press
return on the keyboard.

£
We now have a 3mm square curve. This will represent the
. Princess Cut stone size and will be used to cut the seat for the
¢ = setting area.
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e Close the Offset form.

e With the 3mm square curve selected click on the Offset object button

on the left toolbar. @

e Enter a value of 0.2 in the Distance box then press return on the
keyboard.

This curve will be used to create the clearance for the depth of
ME the Princess cut stone.

All curves for the design are now complete.

il

g 2 e From the list of Workplanes in the bottom
X wvorld 1] left corner select 1 to activate it.
& g v 0 :Generd

e Select the View ISO 1 button on the right toolbar. @

e Select the Solid button on the top toolbar. ia

e Select the Create a solid from drive curve and sections button on the left

toolbar. @:D

@) Drive-Curve g
Selection Mode H H
X ©sectons The red crosses next to Section(s) and Drive-Curve

indicate that nothing is selected.
When items are selected a green cross appears instead of
e the Red Cross.

0 Wal Thickness

X O orivecurve

e s We need first to select the two cross sections created

| earlier at each end of the shank drive curve.

[ Preview H Options H Aoply

[ QK ] ’ Cancel ] ’ Help l
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e Holding down the Shift key,
select the two cross sections
seen here.

Once selected you will notice the green
tick appear next to Section(s).

- .
1 Drive-Curve

- Selection Mode
o () Section(s)
£ Gyivecurve |;|

| e With the left mouse button, click this button
'“%“‘:’a" - here to select it.

[V] Ooffset Inwvardh . . .
il We will now select the ring shank drive curve.

[ Preview ][ COptions ][ Apply ]

[ QK H Cancel ][ Help ]

e Click on the shank drive curve
here and a green tick will
appear indicating the selection.

e Select the Preview button to
see the results.

e Select OK to accept and close
the form.
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This end of the shank will be modified further to include a fillet
radius and solid cut detail.

e Select the Feature button from the top toolbar. a

e Click on the Create solid fillet button on the left toolbar. ‘9

e Enter 0.5 in the Radius box
then select this edge.

e Select Apply and Dismiss the form.

The fillet is applied around the top edge of the design.

We will now create a cut at 0.6mm deep using the 3mm
square curve.

e Select this curve.

e Select the Create solid cut feature button on the left toolbar. E;
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e Enter a value of 0.6
in the Depth box.

e Select OK to create
the cut feature and
close the form.

The pocket is cut to a blind depth of 0.6.

e Trace a new composite curve at the bottom of the pocket edge as
shown

Cieate Composite Curve

1 [ Kl <] b
S|
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e Select this new composite curve
and then

e Create solid cut feature % button from the Solid feature toolbar.

e Enter a Depth of 3
and an Angle 0f 340
(20 deg per side).

e Select OK to accept
and close the form.

J

W%!@ﬂﬂ

The end design is now complete.

If you wish you can undo any changes and apply your
own values.

We are now ready to bring in the Princess Cut gem.
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Delcam Designer

®Standard:

ICarat vl

Size: 0.15 -
Length: |3
Wifidth: |3
Depth: 1.26
€N

Open ArtCAM JewelSmith.

_ & Create New Project
Create a New Project. :

v

': .

Select the Princess Cut button. Frincess

e Select a Carat size of 0.15.

Select the Add Gem @ button from the Assembly Manager area.

e Click the forward arrow to continue.

-

- -‘ﬂ-"*

e Select the Diamond colour button. Diamand

e Select the forward arrow to create the gem. e

s ey

------- @ Fioat .ﬁ.ssemblyPrincesK

e Click on the gem name in the project tree.

e Right mouse click and select Export Gem.

¢ In File name type centre gem and Save as type select Wavefront
Object Files (*.0bj).

Export Gem As...

Savein ‘@ Desktop
CaTom Tom
¢ My Computer

(LMy Documents
4 My Compliter
“dmy Network Places
Dshare-to-wieb Upload Folder
@ ArLCAM Files
(Dartcam
[Dproma
(Siroland

=l

il

o

File name. |3mm princess cut

Save

Save as type |Wavefont Object Files (*.obj)

ﬂ Cancsl

7.20
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Save in Location D:\users\Training\Coursework\Delcam Designer
Jobs

Enter a name 3mm princess cut.

Change the Save as type to Wavefront Object Files (*.obj).

Select Save.

Return to the Delcam Designer window.

e From the bottom left corner select Workplane 3
from the list.

To make positioning of the Princess cut gem easier we will
create a new Workplane in the centre of this curve.

e Select the curve.

e Select the Workplane icon on the top toolbar. k’

e Select the Single Workplane at centre of selection button on ‘ @
the left toolbar.

The Workplane is positioned at the centre of the
selected curve.

e From the top left of the screen select File > Import.
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e Locate and Open the 3mm princess cut.obj file.

The gem is imported aligned to the current active Workplane
but at the world origin.

We need to select the gem and move it to the correct position
at the end of the shank design.

e Select the gem.

@
e Click on the Show general edits options button o the left toolbar.

e Select the Move/copy object button. g’

e Make sure that the move origin is at the
world origin (centre of the gem) before
moving it.

e Click on the key-point at the active
Workplane to move the gem.

e Press o finish the move/copy function.

¢ View the model from right X + to see if the gem is at the correct @
height.

_Inthis case the princess cut
. diamond is perfectly
positioned.
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EoN AR ] —

e From the bottom left of the screen select Workplane 1
wiorld from the list.

E
e Select the View ISO 1 button on the right toolbar. @

e Drag a window around the whole model including the gem
and select the Rotate object button on the left toolbar.

e Make sure that the
blue rotation arrow %
points up the Z axis.

e Enter No of Copies 1 and an
e Angle 180.

e Press return on the keyboard.

e Close the Rotate form.

e Select the View ISO 1 button on the right toolbar. @

The design is complete.

All that remains is to change the materials to 18ct gold for one
side and Silver for the other.

We will then create a rendered image to finish.

Issue Designer 7 71.23



7. Tapered Ring

Delcam Designer

e Select one of the two shank solids.

e Select Format > Materials from the top of the screen.

& Material Selection

Select Metal from

[JUse wireframe Colour L4

IMaterial Type Drefaults
Standard
Cast Metal
ket ECoated Ietal

IMaterials

v

e Select gold 18ct then OK to accept and close the

form.

Spark. Erosion
Marble

Wood
Autumn

[W] Use Inside Colour the pU” down list.

-] |

L

Jold 18ct

e Select the remaining solid shank.

e Select Format > Materials from the top of the screen.

[JUse wireframe Colour

IMaterial Type Drefaults
P Standard
Cast Metal
ket ECoated Ietal

IMaterials

v

Spark Erosion
Marble

Wiood
Autumn

Use Inside Colour

-] |

Select Metal from
the pull down list.

e Select Silver then OK to accept and close the form. @

Sikver

e The model is now ready for rendering.

First you need to rotate and position the model to suit your
preference.

7.24
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, , : 5
 Rotate your model into the desired angle and size.

e Select the Restore down button on the top right hand corner of the
screen.

et . :
& train tapered ring

e Adjust the model window smaller
to allow faster rendering.

¢ Also rotate the design into the
desired position, similar to that
seen here.

e Select the Raise the render form button from the Q%, 0”‘

right hand toolbar. WS |
Lights
() A3 view n the Light e
(®) Override |5Ky | ’ Change..,"]_ hd n e |g S areao e 1orm

select the Change button.

[ ] Automatic Update

’ Render H OK, ]’ Cancel H Help ]

& Light Studio Selector

Light Studio Groups Standard L From the pU” down I|St SeleCt

Light Studios Standard.

'0 'Q 'y h'. e From the Light Studios area click
Standard Stdleft StdRiaht stdCentre StdTob Sky on the Sky button.

e Click on OK to accept the form.
e Click the Render button on the Render form.
e There may be a slight delay before rendering starts.

e Eventually you will be left with an image such as the one seen on the
next page.
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If you are happy with the result select OK on the Render form.

To save the image select File at the top left of the screen then Print to
File.

Search Location D:\users\Training\Coursework\Delcam Designer
Jobs

Type in a name as Finished Ring.jpg then Save.

Select the Save button on the top toolbar to save the model itself. E

Type in name Tapered twist ring.psmodel (in same location) then
Save.

7.26
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8. Chain Link

Introduction.

> This tutorial will demonstrate the interoperability
' . ~ between Delcam Designer and JewelSmith. The
' ' demonstration will move you between the two

programs for the creation of a chain link from
complete design to machining.

!

) & Create New Project
e Select Create New Project

e Select Blanks — 3 Axis Flat e from the Models Tree.

e Leave name as ThreeAxisFlat, Width and Height of 25 with a @
resolution of 30 pix/mm and press Accept.

) Select the ASSIStant tab . Azzishant

e Select Create Rectangle. D

D Rectangle Creation

Settings

Square or Rectangle

E * Rectangle
i Square . . - -

o™ The rectangle creation page appears, showing the options available.

0 mm
B™—.. Clicking in the screen and dragging to a size, or by entering in the
e RI;_m values can create the rectangle.
B Several rectangles can be created without closing down the page.

Angle ID—
Preview
Create Close

e Select the option Rectangle, a Height of 9 and Width of 14
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e Leave Invert corners unticked and Centre Pointisat X0 Y 0 and Angle
at 0.

e Select Preview and then Create and then Close.

The remaining shape of the link will be completed with the aid of guidelines. Guidelines can
be accessed from the left hand and top rulers on the model border.

_

Wmug,k(all

/—ale’ s
e

e Hold down the left mouse button within the left ruler and drag inwards a
vertical guideline, releasing the mouse at the left hand side of the rectangle.
¢ Right mouse click on the guideline and enter —8.5 and Apply then OK.

Position Guide
—Selected Guide ——————————————

Current position -8.500 mm

Mew pozition |'8-5
™ Locked Delste |

— Inzert Parallel Guide [z]

i+ Ahsolute position

" Relative to guide  Coune I‘I _:l
Poszitior: |'3-5 elelly [ B el |

e (1 | ’TI Cloze |

e Drag a second vertical guideline and release it next to the right hand side
of the rectangle.

e Change the position to 10.
e Apply and then OK.

The rectangle will be modified to create the basic outline of the link. This can be done more
effectively in Node Editing.
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e Select the Rectangle and then select Node Editing. TF (Or press N for
shortcut on keyboard)

When a vector is selected, the option Node editing will display the points (nodes) that are
used in this vector. In this mode the individual points can be moved manually by dragging
them to a new position or the curve shape altered by moving one of the control points (shown
as empty squares on a dotted line).

¢ Right click on the right hand side vertical vector of the rectangle Select
Convert span to Arc (or press A for shortcut)

e Drag the Arc until it intersects with the right hand guideline.

e Convert the left hand vertical Span to and Arc.

The position of each end Node (of the new arc) will be changed to alter the shape further.

e Move the cursor over the bottom Node, right mouse click and then select
Properties.
e Enter -3 for Y coordinate and select OK.

Point Properties

General |

% coondinate: I'?
' coondinate: |_3

The coordinates are measured in real units,
[inches or mm]

(]4 I Cancel | Sppll | Help |

e Repeat the above for the top node but enter 3 in the Y coordinate box.
e Drag the left hand arc until it intersects the guideline.
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The shape should now look as below.

—

O

e Select Create Circles.

o Circle Creation

Circles are generated from a circle centre and a radius or
Centre + Size diameter.

Circle Centre
X:0 ¥:[0 The option, create with arcs is mainly used if you are going
DI to offset the circle, or for machining purposes.
* Radius
" Diameter
IU mrim

I Create with arcs

e Setthe Circle Centre as X 5.5Y 0. Select Diameter and enter 5.5mm.
e Press Create and then Close.

e Create a second circle with coordinates of X —4.5 Y 0 with a Diameter of
4mm.

e Select Create Rectangle. D

e Enter awidth of 8mm and height of 1.5mm. Leave the other settings as
default and then select Create and OK.

The two circles and rectangle will be welded together to create a single vector. This will
complete the inner 2D design of the link.
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e Select the two circles and rectangle (Shift button can be used to multi
select)

e Select Weld vectors from the assist page o to create a single vector.

T
S

The vector design of the link is now complete in ArtCAM. These vectors will now be used in
Delcam Designer to create the 3D model.

Creating the 3D model

e Select all the vectors in Jewelsmith and select Edit — Copy

é:)

Designer

e Open Delcam Designer "= and select Edit — Paste.

This will paste the curves from Jewelsmith into Delcam Designer. We will now convert the
curves into solids.

e Adjust the view / position the vectors to obtain a good working view
e Ensure all the vectors are selected (highlighted yellow)

2

e From the Solids toolbar ‘a select Solid Extrusion
e Enter alength of 1.5mm and select OK.

A 1.5mm thick solid(s) has been created from the selected vectors. Note: As two separate
vectors were selected, two separate solids have been created.
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The inner solid will be removed from the outer solid to complete the basic flat shape of the
link.

e Select the outer solid and Right click over it to bring up the sub-menu and
select Active.
e Select the inner solid with the left mouse button.

The solids history tree now shows the active outer solid (denoted by the red flag) and the
inner solid selected (boxed).

e From the Features toolbar @ select Remove the selected Solid from

the Active Solid. @

&

The edges and corners will now be filleted

e Select the top face of the model

e From the Features menu @ select create solid fillet. 9

e Enter aradius of 0.3mm and select Fillet a face.
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e Select Apply but do not close the form.
¢ Rotate the model to apply the same fillet on the other side.

e Select the surface. Select Apply then Dismiss.

This completes the fillets on the inner edges of the model. The outer edges also require
filleting.

e Select Create solid fillet 4 again from the Features menu %
e On the Fillet form, select the Follow continuous edges option.

e Multi select (shift button) the complete outer edge of the model.

e Ensure the radius is still 0.3mm and select Apply.

e Repeat for the other side and dismiss the Fillet form.

The model is now completely filleted. The shape will now be further altered using the
powerful Morphing function of Delcam Designer.
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Morphing the model

e From the Feature tab E select Create a morph feature 9

¢ Inthe Morphing box select Flexible box and then Stretch box ﬂ

e Select the vertical face on the narrower end of the model. Use both the up
and down arrows to stretch the model until it looks like the image below.

Pull arrows to stretch box.

e With the face still selected and the Morphing form open, Select Twist the
box E

e Twist the circular arrow approximately 90 degrees, and then OK the
morphing form.
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Rendering the model

If required at this stage, the model is ready for exporting back to JewelSmith to calculate the
toolpaths.

But before that, the Rendering functionality of Delcam Designer will be demonstrated.
Rendering allows realistic shading of the model to represent the intended material.

Ensure the model is shaded O

Select the model and from the top menu bar Select Format — Materials
Select Custom and from the pull down menu select gold new.

Apply and OK the material selector form and then OK the materials
selection form.

The link is now shaded in the gold, but can be enhanced further.

e From the shading toolbar, select Enhanced shading ﬂA

The model is now enhanced to a more realistic (metallic) shade.

Chain assembly

Multiple copies of the model link can be easily created then joined together to create a chain
(e.g. bracelet), and presented as a finished piece.

¢ Revert the model back to standard shading O
)
e From the top curve menu (D select create a bezier curve ©
e Zoom and position the model accordingly, and then draw a complete
bezier curve around the model as shown below.

Note: snap to the keypoint to complete a single curve
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This bezier curve will be used as the drive curve. Multiple copies of the link model will be
created and positioned onto this drive curve to create our chain.

The orientation must be firstly checked to obtain the correct result

e Ensure the Z workplane is selected from the bottom views

toolbar.%%@
=

The model and drive curve are positioned correctly and now ready to create the chain link.

e Select view from top (+2)

e Select the model and from the General edits toolbar + select Create

I
pattern of objects Ei

e Select the Wireframe tab and then select the drive curve from the
workspace.

e Select Rotate copies to axis from the orientation pull down menu,
and then select the option equal with from the spacing menu.
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8. Chain Link

@i Pattenn Edit

| Rectangular | Honeycomb | Cirular | wireframe

( Wireframe selected
L W

D
v v

Range
(& Full wireframe

Spacing
O At keypoinks

) e
(&) Equal with = copies
O Every 19,282 | | From start

Placement

O 3 I

. + g
wven. [ 9] @
i i = Reverse

0K ] [ Cancel ] [

Help

e Adjust the number of copies using the arrows until the links combine

correctly.

e Select OK to generate and complete the chain assembly.

Note: The single link can be hidden from view by selecting it first then CTRL-J (Blank)
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Advanced Rendering

Delcam Designer includes further Rendering options to enhance this completed chain design.

)
e Raise the Render form Qg by selecting the option from the Rendering
toolbar.

e Inthe Render form select the option As View in the Scenery and Image
resolution menus.

¢ Inthe Lights menu, select Override and then change the option to
SpotsfillA

The form should like as shown below.

@ Rendern EJ
Image Quality
Presets Best hd
Method Ray trace Full ~
Shadow Full ray cast
SCEMery
(3 As View
(I Floor
O Box
Image Resolution
() As View
) As Printer
O Custom
() standard
Lights
() As View
(&) Overtide SpoatsFila

Aubomatic Update
[

[ Render 1[ 0K ][ Cancel ]l Help ]

e Select Render

The model is rendered in a new window. Note: The time taken to render can be reduced if the
window size is decreased.

e Experiment with the different options to see the different effects before
selecting OK.

The toolpaths for the link will now be calculated using JewelSmith.
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8. Chain Link

e Select the original model using the window menu.

e Select the single separated link and then CTRL-K.

This keeps the link but hides (blanks) the remaining chain from view

e Select the model and then Edit-Copy from the menu bar.

Machining the model

e Return to the original Chain Link Project in ArtCAM
JewelSmith.

If the ArtCAM model (vectors) is still open then close the current
model.

e Right click on Assembly in the Project tree and
select paste.

The Delcam Designer model is now pasted into JewelSmith. The
‘triangulation’ surface finish can be improved by right mouse
clicking the New Assembly, and then selecting Smooth.

5 [Urtitled)
- r.ﬂ_ Models

Sl
Hide

Mew
Impaort...
Expart...

(501t
Copy

[Ereate Bl

[Ereate Fatary BEliEf

St
Reverze

[Eelete
Fename

5 (Untitled)

S
Hide:

EditAbre]
Export

Cut
Copy

Create R elief

Create Rotary Relief
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f.
e Select the Assembly root folder and Multi-Sided Machining @

e Change the output folder to Machining Output Folder
D:\users\Training\Coursework\Delcam Chternp Browse... |
Designer Jobs Inutput prefix

|(Untitled)

e Change the Output Prefix to Chain Link

e Select Edit Settings. __Eatetings |

@ Multi-Sided

Machining
Show Help [EHE2
Model Type
a""r " Flat

@ ¥ Ring

e Select Ring and then Forward.

)

)

e Select Forward. On Model Size.

e Select the Rotary and Indexed options. This will combine rotary and
indexed (predetermined angles) to machine the complete link.

Machining Orientations

@ [ Inside

F@ '7! ndexed
Y

)

e Complete the form as shown below.

e Select Forward.

8.14 Issue Designer 7



Delcam Designer 8. Chain Link

@ Multi-Sided Machining

Show Help  [H B3

Rotary-Axis Template
ot 2mbnimbn-5

Ty, 25t tof andal Select the templates from ArtCAM Files\Toolpath

L/ Fomaariaycem <] Templates\Alcami\Roland JWX\
Jig Diameter |2 mm

d

Bridges

Mumber 0
Width 2 mm
Thickness 1 rem

Indexed Template
= RuiZmbni-
\ Smbnconicaltpl

o e o Ensure the correct JWX Roland machine is selected for Rotary-

Select...

i

b 2 mm  Axis and Indexed respectively.
Jig Offset 1] mm
Start Angle 1]
End Angle ’W
MNumber of Steps 4
e o For the Indexed Template, 4 steps within a total angle of 360
A Tabs - degrees will ensure rotary increments of 90 degrees.
Twwo Tahs i
Tah Offset 0 o
Tah Rotation
Cut Through To Back [
()

e Select Forward e and press Accept @ to commence the toolpath
calculation.

ACAM Jewelsmith x|
"j The machining wizard has now finished.

The post-processed files can be found in the directory specified.
The toolpaths are stored within models inside the Project. To keep these changes the project will need to be saved.

e Select OK to accept the Machining

S Show in
S 2D/3D
. [rurZmbnFront] A
A total of eight toolpaths have been created. They can  “galiNose 2 mm r~
be simulated to show the final result. Note: [fin0-Smbnconfront]
Si lati is displ d df larit hall nose taper [ v
imulation is displayed un-wrapped for clarity. {90} [rufzmbn - Rotation: 90]
Ball Mose 2 mimn W+
{180} [rufZzmbn - Rotation: 180]
Ball Mose 2 min [ [
™ Draw Solid
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9. Twisted Collet.

Introduction.

This tutorial will demonstrate the interoperability
between Delcam Designer and JewelSmith. The
demonstration will move you between the two programs
for creation of the custom collet.

S

. @.c_rem-um Project
e Select Create New Project R
e Select Blanks — 3 Axis Flat = from the Models Tree.

e Change name as Untwisted Collet, Width and Height of 10 with a
resolution of 30 pix/mm and press Accept. @

Q? Poly Line Creation

Show Hel e Select the Assistant tab, =5

dx
1744, Next Point
x

e Select Create Polyline. ':?

x o Y |0
degs |D L |D
dx o dy |0

A poly-line is a continuous line made up of two or more points.

+ Cursor Position
% X2 -11.229 Y: -30.743

DL These points can be entered by clicking on the screen, clicking
W o Y: 0 on the end of lines, or by entering the actual or relative co-
Angle and Length H
_/é}; degs -110.064 L 32729 Ol‘dlnateS
% Change in XY A A
—t ax 1229 ay-30743 By holding down the mouse button and moving the mouse,

freehand sketching is generated.

[~ Draw smooth polylines
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The ability to smooth poly-lines when creating turns the lines into curves as you enter the
points.

e Untick Draw Smooth polylines. Enter X -1.5 and Y 1 and press Add.

This is the starting point of the poly-line and nothing is seen in the 2D view.

Enter L 3 and press Add.
Enter dx —1.5 and dy —1.5 and press Add.
Enter dx —1.5 and dy 1.5 and press Add.

Select Close.

The diamond is now complete the next thing that we will create will be the shapes for the
collet.

Select Create Polyline. l:?

Enter X -1.75 and Y 1 and press Add.
Enter X —-0.6 and Y -2.5 and press Add.
Select Close

The straight line will now be converted to a curved line

e Select the line and then Select Node Editing. T" (or press N for
shortcut on keyboard)

When a single vector is selected, the option Node editing will display the points (nodes) that

are used in this vector. In this mode the individual points can be moved manually by dragging
them to a new position or the curve shape altered by moving one of the control points (shown
as empty squares on a dotted line).

9.2 Issue Designer 7



Delcam Designer 9. Twisted Collet

¢ Right click on the line and Select Convert span to bezier (or press B for
shortcut)

e Drag the handles (empty squares) so they look like the image below.

a—

e Press select vectors. A
e \With the line selected. Select Offset vectors. °

e Select an Offset Distance of 0.2. Select Outwards.

Select the original line again, Select Inwards.
Select Close.

Select Create Polyline. t?

Enter X —-1.2 and Y —1.2 and press Add.
Enter L 1 and press Add.

Select Close.

This will give you a horizontal line across the 3 vectors. This new line will be used to create
the base of the collet.
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2.
e Select Trim vectors to intersections. >\§‘?

The mouse arrow is replaced by a scissors icon. h This dynamic icon changes to open

scissors . when it has found some vectors it can trim back.

e Remove the top left vector the top right vector and either sides of the
horizontal line as shown below.

e Select the 3 vectors and Join == them together then close the line with

Close Vector With A Line C

Select Create Circles. O

Enter X -1.25 and Y —-0.5 and diameter 0.4.

Select Create.

Enter X -1.6 and Y 0.3 and diameter 0.4 to create a second circle.
Select Create and Close.

We now have the completed vectors that we will use to create the surfaces in Delcam
Designer.
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Creating the surfaces

e Select all the vectors in Jewelsmith except for the diamond and select
Edit — Copy

e Open Delcam Designer 7% and select Edit — Paste.

This will paste the curves from Jewelsmith into Delcam Designer so that we can convert them
into surfaces.

e Select the closed rectangular polyline and the y-axis (use the zx ‘face’ of

the workplane). 7 @ A

e Go to the Solid tab and select the Create a solid of revolution button

e Select the first circle and select the Create a solid of revolution button
e Repeat this with the remaining circle
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The next thing that we are going to create will be the prongs. To do this, we can create one
prong, and then rotate copy the remaining.

e Select the Arc Menu
e Select the Full Arc option from the menu. ‘

e With the y — axis still selected, place the centre of the circle at the top of
the single polyline and scale the circle to a radius of 0.15mm.

e Select the single polyline and the newly created circle and using the

Automatic — Surfacing wizard N&
tube.

apply a surface, which will create a

e With the Automatic — Surfacing wizard still open, select the circle and
apply a fill-in surface to the top of the tube.

9.6 Issue Designer 7



Delcam Designer 9. Twisted Collet

e Select the two new surfaces the tube and the cap (make sure you are in
T
N

the y-axis) and from the General Edits + tab, select the Create

[ W R
pattern of objects button. B
e [n the Pattern Edit box select Circular.

e Enter 6 into the Element box, and press OK.

Creating the Twist

e Select the 6 prongs and from the pull Solids toolbar e select the Make

et
i/
solid from surfaces. % This will turn the prongs into solid objects

e Select the base and make it the active solid this can be done by selecting
the base then using the right click mouse button and selecting Active.

e Select all the other surfaces and from the Feature tab select the Add the
selected solid, surface or symbol button, this will turn the individual

solids into one solid L—ELl

e From the Feature tab % select Create a morph feature O

e Inthe Morphing box select Flexible box and the Twist box select the top
of the box and rotate the arrows till the twist looks like the model below.
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The collet has now been completed

Save the model in D:\users\Training\Coursework\Delcam Designer Jobs
as Twisted collet.psmodel
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Exercise — A Carved Bowl

Introduction

This tutorial will guide you through the process of creating the bowl shown above,
and decorating it with a 3D relief created in ArtCAM.

Key features covered in this tutorial are —
e Sketching complex wireframe
e Creating a surface
e Wrapping an ArtCAM relief
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Sketching the Wireframe

Begin by creating a Workplane at the world origin (0,0,0) and rotate the view to
(approximately) an isometric orientation.

Click on

Create a line (in single line mode) ‘ / from the origin, 70mm along -X

Create a second line that begins at Z 180.
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Set the length to be 200mm along —X.
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Set the working axis to Y w
Create a swept arc

points in the order indicated).

between the end points of the two lines (click the

4 Issue Designer 7



Delcam Designer A Carved Bowl

@ Arc Confirm 3
Radius

200 |NEH:tSﬂll.lhﬂn

Set the Radius to 200, and click OK.

@ Arc Confirm g3

Set the view to be along the Y-axis (Ctrl + 2).
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Click the ‘Create Circle’ icon O

Set the radius of the arc to 5mm by typing ‘r 5" in the Command Input box.

g Tol 0.01 r5 ¢

(Press <Enter> to accept)

Create the first circle at the top of the original arc as below.

6 Issue Designer 7



Delcam Designer A Carved Bowl

Create a second circle a little lower, but make sure its centre is still snapped to the
first arc.
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Create a swept arc tangent to both circles and touching the first arc.
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Select the large arc and the line at the base of the bowl.

Issue Designer 7



A Carved Bowl Delcam Designer

Convert the arc and line to a composite curve.
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Edit )
Undo Ctrl+Z
Cut Ctrl+x
Copy Ctrl+C

Paste Attributes

Select »
Delete
Convert 4

Solids to surf;
Add to active workplane group OlEs 10 surtaces

C rfi ithin solid
Remove from workplane group opy suffaces within sollds

Wireframe to composite curve [%
Chamfers to lines

General Edits »
Fillet Corner...
Open the General Edits toolbar || S%%,

Click on Offset

OJ

Offset the curve by 5mm — making sure it goes in the correct direction!

Notice that a small arrow is drawn on the curve. This is the direction the curve will
move in if you enter a positive distance. If the arrow points down (or out) as in this
case, you must enter -5 in the Offset Distance box.

Offset

ﬂ ™ ||:E|Nn. of Copies 1

——

| Distance a

If the arrow points up (or in) enter a positive value.
e Select the line at the top and change its length

(Zoom in on the line at the top of the bowl. Grab the end of the line, and drag a little
to the left to lengthen the line so it passes through the circle)
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Take care not to change the angle of the line, but only its length.

Create a composite curve m
]

Start the curve at the bottom the inner curve.

x

(@I KA DI @ §t iia
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A Carved Bowl

Trace the curve step by step, as in the following images.

Save the
composite

Press

LT EONSE

to exit the composite curve creator.

Making the bowl.

The bowl is created as a simple solid of revolution.

Set the working axis to Z ﬂ % % i

Open the solid toolbar

Create the solid of revolution 6

Issue Designer 7

13



A Carved Bowl Delcam Designer

Decorating the Bowl

The decoration for the bowl is an ArtCAM relief model that has already been
triangulated and exported in dmt (Delcam Machining Triangle) format.

View the model from underneath (Crtl + 0)

Open the Solid Feature toolbar
Open the Wrapping form Ej

14 Issue Designer 7



Delcam Designer A Carved Bowl

(@ Wrap Wizard - Wrapger Selection &3]

Select the items to be wrapped B Ee
onto the targets

AF

o4
~

Wrapper Items

Use settings from previous unwri

x Wrabpers Selected

<Back Next> Finish | cancel || Help |

Click the DMT/STL File button to open the file selector and browse to the file-
RoundDesign.dmt

rm]
Lok in: | £ JVG - Carved Bow Q T E-
@ ] RoundDesign.dmt
Jph
Ny Computer
My Metwark
Flaces

2 File name: | RoundDesign.dmt

Transfer (H) | Bieg of ype: | DM File ( dmt)

<[]
1]

Click ‘Open’.
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i Wrap Wizard - Wrapper Selection m

4 Select the items to be wrapped B Ee
“ 4 onto the targets

i Wrapper Items
Use settings from previous unwri | (3 selected Symbols

(%) DMT/STL File

{ Wrappers Selected

-

<Back {W} Finish | cancel ||  Help |

Choose the ‘Plane’ wrapping method, and then click ‘Next'.

i Wrap Wizard - Wrap Method m
e Choose wrap method T
Ty

Method
O Chard
F@ Flane
Cylinder
Quv

Cone

This controls how the wrappers

will be applied to the target

=
[ <Back Mext= Finish [ Cancel ][ Help ]

IMPORTANT NOTE: The correct choice of wrapping method is absolutely essential
to getting a good quality result. For a full understanding of the different methods
available you are advised to read the relevant manual section. The following short
descriptions will hopefully give you an idea of what is going on.

Chord. This method does a true ‘wrap’ with the minimum possible distortion.
Imagine taking a flat sticky label and attaching it to a curved surface. Because the
label is not very ‘stretchy’ there is a limit to how highly curved the shape can be
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before the edges of the label begin to ripple. Also note that method will not work on
closed objects, as in order to calculate the ‘wrap map’ Delcam Designer must first
unwrap the target to a flat condition.

Plane. This method works by projecting the label onto the target along the current
view direction. This method works best for shapes where curvature is not too
extreme.

Cylinder. This method constructs a cylinder that contains the target surfaces/solid,
and projects the label inwards from the cylinder onto the target(s). This method
works very well for parts such as bottles and rings.

UV. The UV method constructs its wrap map according to the layout of the surface’s
Lateral and Longitudinal curves. Results will therefore be best when the spacing of
these curves (and their relative lengths) is fairly uniform.

Cone. A perfect cone can be unwrapped into a segment of a circle with no distortion.
Conical unwrappping projects the geometry to be unwrapped onto a cone and then
unwraps the cone, and the geometry with it. Create a cone primitive that
approximates the geometry to be unwrapped, select the geometry and the cone and
enter the wrap wizard. The amount of distortion in the result depends on how well
the geometry approximates a cone.
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The wrap preview image shows how successful the wrap will be. If the preview is
nicely uniform (as in this case) the wrap should also be even. If the preview is badly

distorted, that distortion will be present in the wrapped relief as well, and you should
go Back and choose different options.

Use the sliders to adjust the size of the relief until it looks as you want.
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A Carved Bowl

@ Wrap Wizard - Wrapper Layout &3

£ 5= =5 S
A t Layout the wrappers on the
True Size [ Mirror Width
7
. b
Width Offset 0.000 Size
1 1
L] L]
Heiaht Offset 0.000 Aspect 1.000
1
ot o]
[ <Back et ] Finish [ Cancel ] [ Help

)

Issue Designer 7
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(@ Wrap Wizard - Wrap Triangles |9

e ) -
o ~ Apply triangles wrapper to the
targets
[¥] Trim Male Inwards [ |ile Settings. |
Heiaht Relative v| 10 |

Offset Alona| Surface Normal |

[ Preview ] [ Holes... J[ Defaults ]

Patents Pending GB2389764, US 10/174,524

| <Back || next= | Finish )| cancel || Help |
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A Carved Bowl

Adding the Base

Set the working axis to Z. %

Create a circle of radius 70mm with its centre at 0,0,0
Create a second circle on the same centre with a radius of 60mm

Select the 70mm circle, and create a solid extrusion. @

Set the extrusion so it looks as below.

Issue Designer 7
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Delcam Designer

Make sure the new solid is Active.

Select the 60mm circle, and use the Solid Cut feature to

[ B N .

remove it from the active solid.

Solid Extrusion 4 (General)

Cut

Copy

Paste

Paste Special
Delete

Mext Selection
Clear Selection
Select All

Blank
Blank Except

Undao
Redo
Selection Information

Convert
Copy All Surfaces
Modify...

Make Watertight

Reverse g

Style From Surfaces

Make colours from features

e &

22
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@ Solid Cut 3
o
~ Bxtrusion

Depth
A
Reverse
[ Extrude both directions

~ Sketch

ame o

| Edit.. || Replace || Delete |
X Relationship (=5

Add selected sketch
Add sketches from symbols
Remove inside material

[]Group nested sketches
Alternate nested draft angles

[ ok || cancel |[ Help

Make sure the cut feature will pass completely through the first solid, then click OK.
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Delcam Designer

& File r: View Objec: rma.tl Tools Macro—moduie V-;:ndm Help = 8 x
YL D Y e v
1Y
, @
o =
] ®'
:
% |
=S &
bl Q
@ ,
) O
@ o
9 %
Q Y
&« _
¥ Erloll1]l2][3][4]
&, worid 0 :ceneral (v %% G #H |[39434 | 0 | 128027 || @ | 7o 001 | Delcami() J

Save the model in D:\users\Training\Coursework\Delcam Designer Jobs as
Carved Bowl.psmodel

24
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Exercise — Modelling a Corbel

Introduction

The aim of this exercise is to design the corbel [a support for an arch or similar heavy
structure, which sticks out of a wall and is usually made of stone or brick] shown in

the picture above.

Beginning with a Delcam Designer model that contains the key wireframe curves for
the design, simple surfaces will be created. These will be trimmed together (to
remove unwanted material) to complete the shape. Finally, decorative reliefs will be
wrapped onto the surfaces to finish the design.
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Stage 1 - Creating the Main Surfaces

Click rf' to import the Model data.

[ —|
@1 Select A File To Impo 2 B3
Lookin: | [ Corbel_data QT om-
seaccad dsamt
reliefs.dmt
swirls.dmt
Places
i File: name: ||::orbel pamaodel . Open -
Tenster 1) | Fesoftype: [ mportable Fies (") Cancel

Browse to the model file and click Open.
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FreweETI® Tl Lo

@ Flle Edit View Object Format Tools Macro Module Window Help -8 x|

CRFRAAS L N(ELN 9 B LNWOCA/AYOS

x|

8.~ |

eOCPS R !
E LY R C R

* & (o]l1)2[3](4 3538
b lv| 0 iceneral v B %S HE | |-84.204 | 145219 0 = g T 00 £2DELCAM

Rotate the view so as looks like the image above.

Click the X Axis icon (on the bottom toolbar) to set the Working direction.

Open the Create Surface Toolbar

Select the GREEN curve and click the Revolve icon ‘6

The surface will look like this —
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Select the RED curve

Click the Extrude icon Q

The extruded surface will look as below.
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Set the working axis to Y

Select the C VA curve and create a second Extrusion as below.
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This extrusion is going the wrong way. Pick the BLUE arrow at the position shown,
and drag the extrusion so it is correct.
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~

Make sure that the two extruded surface fully cross each other as shown below —
adjusting the lengths of both as needed. The two surface must look as below before
you go any further.

Issue Designer 7



Modelling a Corbel Delcam Designer

8 Issue Designer 7



Delcam Designer Modelling a Corbel

Stage 2 — Trimming the Sides

Open the General Edits toolbar —

@l File Edit View Object

Choose the ‘Limit Selection’ icon
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Select the two surface at the positions shown below (the order in which you make
the selections does not matter).
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Modelling a Corbel

The result should look as below —

Issue Designer 7
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If not, simply press the ‘Next Solution’ button on the ‘Limit Selection’ form, until the
desired result is achieved.

ant selection

[ cutting object 3¢ T3 1A @ | a@ﬁﬂg 2 }—‘2

When the surfaces are correctly trimmed press the
Trimming.

Notice that these two surfaces are displayed in red. That is because they are
currently incorrectly oriented; they are inside out. Select the two surfaces, click the
Right Hand Mouse button &3 and choose ‘Reverse’ from the pop-up menu.
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Rotate & zoom the view so it looks as below, and set the working axis to X

®

Issue Designer 7
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Open the Arc Creation Toolbar O
Click on the ‘Full Arc (circle)’ icon ‘G)‘

Snap the centre of the arc to the end of the centreline (DASHED).

Drag the new arc’s radius so that it exactly matches the open end of the surface of
revolution.
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Use the ‘Limit Selection’ command Aﬂf
F|

to trim away the unwanted piece of the side surface, as shown below.

Issue Designer 7
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Stage 3 — Creating the end cap

Select the arc created at the end of Stage 2.

Make an identical Copy of this arc —
Either press ‘Ctrl C’ followed by ‘Ctrl V'

OR

i

@ Click followed by

Change the radius of the new arc to 18 (or simply drag the radius until you think it
looks right).
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Select both arcs and user the Automatic Surface wizard to create a trimmed ‘cap’
surface.

9

Click the Automatic Surface icon ;a

Open the Surface Creation Toolbar

Click OK to accept the new surface.

@ Automatic-Surfacing

Surface Type Method
PowerSurface(s)

NURBS

Options

Automatic Previewing

Tangent to Surface(s)

[ CompCurve Creator ] |FiII—In M

[Pre'view] [ Apply il ¥ Cancel ][Advanced] [ Help ]

Select the smaller (inner) arc, and create an Extruded surface.
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Double-click the new extrusion surface to open the Extrusion edit box. Set the
parameters (roughly) as follows —

# Extrusion x|

Dimensions |Wnrkspace || Sketch|

Mame

5 —
Length {|-2 ,
Draft Angle QJ

Negative Lengt | 0

[ s

["1Equal lengths i

| Ok || Cancel || Help |

Click OK when you are happy.
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Create a composite curve around the open edge of the new extrusion. Put the cursor
over the edge and press Alt (on the keyboard) and the Left mouse button at the
same time.

Use the Automatic Surface wizard to make another fillin (cap) surface.
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i Automatic-Surfacing

Surface Type Method

PowerSurface(s)

NURBS

Options

Automatic Previewing

[ITangent to Surface(s)
[ CompCurve Creator ] | Fill-In Iﬂ

[Previ,ew] [ Apply ][ oK ] [ Cancel ][Ad\ranced] [ Help ]

Click OK to accept the surface.

The tapered extrusion and the fillin surface are both inside out, and must be
reversed.
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Stage 4 — Finishing the Modelling

Rotate the view (approximately) as below.

Select everything, and open the General Edits toolbar.

Click Mirror ﬁ

Mirror the surface (making sure ‘Copy’ mode is ON) through the YZ plane.

The result will be as below.
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Press @

Click the Create Line icon W

to quit Mirror mode.

Select the Rectangle option

Sketch a rectangle across the diagonal corners of the open upper edge of the corbel.
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While the lines are still selected use the Automatic Surface wizard to create a planar
fillin surface,

@ Automatic-Surfacing

~Surface Type—————— ~Method

PowerSurface(s)

*' NURBS

~ Options

Automatic Previewing

Tangent to Surface(s)

[ CompCurve Creator ] | Fill-In

[ Preview | [ Apply |[ ok | [ cancel | [Advanced| [ Help |

Click OK to accept the new surface.

At this stage there is some wireframe geometry that is not longer needed. Select all
the wireframe using the fast selection toolbar,

O

and either [& click from the top toolbar, or press the Delete key.
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Delcam Designer

Stage 4 — Adding the decoration

Press ‘Ctrl 2’ or click the ‘Front’ icon

to view the model from the front.

o

Select the two surfaces that form the main front face of the corbel.

Pick the Wrap icon @

@ Wrap Wizard - Target Selection

X

v Taroets Selected

[] Set target type
F

Select the item(s) to wrap onto

B

If you will be using chord-length
wrapping then the target must be
a single surface or a watertight
solid.

Test Wrap
arve for extrusion

Finish [ Cancel ][ Help

The surfaces to wrap onto are

already selected, so click ‘Next’.

24
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9 Wrap Wizard - Wrapper Selection ||
Select the items to be wrapped B Ee
onto the targets

&
4

A
N
<

~Wrapper tems
(¥ Selected Symbols
;-.--'—__-_ .

7 ) DMT/STL File Load...

[luse settings from previous unwri

x Wrabpers Selected

<Back Next> Finish | cancel || Help |

The ArtCAM relief files to wrap have already been converted to triangles and saved
on disk as dmt (Delcam Machining Triangle) files.

When you pick the dmt option the file browser will open allowing you to select the file
to use.

reliefs.dmt
swirls.dmt

File name: |cerrtre corbel dmt

Transfer (H) | Bieg of ype: | DM File ( dmt)
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Locate the file ‘centre_corbel.dmt’ and click ‘Open’.

i Wrap Wizard - Wrapper Selection m
B e

s Select the items to be wrapped
“ 4 onto the targets

Wrapper Items
[Juse settings from previous unwri (0 selected Symbols

() DMT/STL File Load...

Finish [ Cancel ][ Help ]

Notice that the Wrapper Selection form shows you an image of the relief file. If you
select the wrong file by mistake you can simply click ‘Back’ and choose a different

relief.

@ Wrap Wizard - Wrap Method Ei
e 5 Choose wrap method o n Bl
ey

Method
Chord
(*) Plane
O Cylinder
Cuv
Cone

This controls how the wrappers
will be applied to the target

P
[ <Back Mext= Finish [ Cancel ][ Help ]

For some shapes you will find that you can achieve a better result by using a
different wrapping Method. The simplest method (plane) is selected by default. See
the manual and on-line help for complete descriptions of the other methods and

where they should be used.
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: : :

;SR

True Size [ Mirror 1nwl:]_mrmr Height
[ [ ﬂ :
1]
Width Offset _ 0.000 Size 1.000
-
L]

g Layout the wrappers on the \ - o - ,

=

Pl o
- - - , o
M Y
“ Y e : N T "

| -

Height 0.000 Aspect 1.000 s el __ -"__: T
: b4

: il Reset

Rotation II' - E 9 .

[ <Back | [ mext- | Fiish [_cancel ] [ Help — D

Z

L.

The default wrap is shown as a preview. At this stage the result is simply graphical
(as if a 2D label had been applied to the surface). Using the sliders on the form you
can adjust the size, orientation, aspect ratio and position of the final 3D relief. Adjust
the Size and Height Offset sliders until the preview looks as below.

When you happy with the preview, click ‘Next'.
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# Wrap Wizard - Wrap Triangles X
5 _ F-F -
& t Apply triangles wrapper to the
targets
[#] Trim Male Inwards [ |ile Settings
Heiaht Relative v| 10 |

Offset Alona| Surface Normal |

Preview ] [ Holes... ][ Defaults ]

Patents Pending GB2389764, US 10/174,524

Cancel ][ Help

% PowerSHAPE 7220 - [corbel] M= X

@ File Edit Wiew Object Format Tools Macre Module Window Help — | & x

@@E@ >‘V’<|—Dcﬁf§l§"‘) ,0@)‘ uwogﬁ‘g‘e@‘hé>(

OO PR O£ UL

"
v

S |
=

Lo word (v 0 icenersl (v B Zp T H | [-11481 |0 | 21854 | & § Tol 001 £20ELCAM

The partially decorated corbel.
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Complete the decoration by adding two more reliefs.

Corbel after adding ‘Swirls.dmt’.

Corbel after adding ‘Recessed_detail.dmt’.

Issue Designer 7 29



Modelling a Corbel Delcam Designer

Stage 4 — Rendering

Rotate the View as desired.

Select the entire model.

Click on Format from the top toolbar.

Click on Materials from the Format pull-down.

@ Material Selection - X
Material Type Defaults v | [ ¥se Wireframe Colour
laterial for Standard ! f Use Inside Colour

Metal

Layout [: Cast Metal Extures... | Delete

Coated Metal

15 rosion =
Id bluegrold greenld lightgre

-n e Q-

Meon
nold brow old musta old orangnold vellov nold black

Pastel

Silk W

Spring 1
“|summer AW W

Satin
mold arev mold gold o Tropical old metall
Winter

Leather
matt
Defaults
Textile
Skin

I A

Materials

Glass
solid blue urface blu njMetallic
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Choose a marble material from the form, and click OK.

r@ Material Selection

-,

X]

[ Custom... ] [ Textures...
Materials
MrBluel rBluePoll MrBluePol2 MrBluePolz

[ Cancel ][ Help

Material Type Marble + | []Use Wireframe Colour
Use Inside Colour

From the views menu, select ‘Enhanced Shading’. '@ O @ @

This set the view to be perspective, so more natural, and also applies a reflection
map to your scene. Shiny materials (particularly metals) will look much more

realistic.

Open the Render options

Alternatively you can click on ‘View’ from the top toolbar, and then select ‘Render’

from the drop-down list.

Issue Designer 7
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Delcam Designer

Set the values as shown below.

#1 Render

Image Quality
Presets

Method

Shadow

—
(&) As View
(O Floor

(O Box

. olution
(®) As View

() As Printer

() Custom
() Standard

Best L

Ray trace full w

Ray cast w

() Override Change
[ Automatic Update

=
[ Render OK Cancel ] [ Help

32
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Open the Light Studio selector, by clicking ‘Format’ on the top toolbar and choosing

‘Lights’ from the drop-down list.

@ Light Studio Selector 3
'I'h.
Light Studio Groups ’Jgiamjard w

Light Studios

o ja o jo.

Standa rd StdRight StdCentre

—

/( oK flﬂ Cancel ][ Help
Click the Render icon. Gj
':.._ _|.|l-' ¥ |

NOTE: The ‘Sky’ light studio provides very realistic soft shadows, and provides a
much more natural looking finished image. However, processing can take some
time. With render set to ‘As View’ from the option form, the rendered image will be
the same size as your screen view. To speed up rendering make your screen size
smaller, by shrinking the view using the normal Windows controls.

Save the model in D:\users\Training\Coursework\Delcam Designer Jobs as
Corbel.psmodel

Issue Designer 7
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Exercise — Decorative Column

Introduction

Beginning with some very simple sketches, this tutorial shows how to design the
decorative columns shown above. Because the columns are designed using features
and patterns elements of the design, such as the number of flutes can be changed

very quickly and simply.
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Importing the Data

e Select Create new Model
e Create a Workplane at 0,0,0

Start by importing the Delcam Geometry Kernel (DGK) file that contains three simple
wireframe curves.

File
Mew
Open... Ctrl+0

Open Component Library...

Close Ctrl+F4
Save Ctrl+5
Save As...

Save Thumbnail
Properties

Examples...

Print... Ctrl+P
Print Preview
Page Setup...
Print to File...

Feset
Delete...

Impaort L Import...
Export... Import Wizard...
Import Point Cloud...

Material Import/Export r
Recent Files r

Exit Alt+F4
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@ Select A File [To Import

Look in: | =3 Column_Data ™ €] % o [k

’ ) Column_Profile.dgk

Jph

C

My Computer

-
(2
My Network
Places
I ) File name: Column_Profile.dgk V
Transfer () | Fies of type: Importable Files %) v

The three curves (which are composed entirely of straight lines) are shown below. If
you prefer, you may sketch your own lines and curves. Do not forget that they must
be converted to composite curves before you continue.

NOTE: In this example the central column will be a closed, cylindrical shape. Make
sure, if you use your own curves, that they will correctly join onto the centre-line as in
the imported example.

Making the Main Solid

—— —

v BBk
Select the black curve. Notice that its ends line up with the Y axis centre-line, so that
it will close correctly at the ‘caps’ when rotated into a solid.

Set the working axis to be Y.
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Open the solid toolbar

Click the ‘Solid or Revolution’ icon 8

This will create the shape shown below.
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Create two more Solids of Revolution using the two remaining (red) curves.
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Adding a ‘Flute’

e Click the ‘Crate Arc’ icon from the main toolbar. @

e Create a ‘Full Arc’ (circle) ‘

e Create acircle at centre 2.5 -16 0 with a radius of 0.2 mm

Snap the centre of the circle to the position shown below, and set the arc’s radius to
0.2 (or use your own judgement for the value if you prefer).

With the arc still selected, create an Extruded surface.

Click a\ from the top toolbar, then U;?,

By default, the new extrusion will look as below.
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o

The direction of the extrusion needs to be reversed, and also the length must be set
correctly. Double-click then extrusion.
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This opens the Extruded surface edits form. Set the length to -32 (If you have
sketched your own curves, set the length accordingly).

Dimensions | Workspace " Shetch]

[]Equal lengths N

(Co)) (conee ) (e ]

This new surface will be joined to the initial solid column using a Boolean.

Activate the Solid Features toolbar

Click on ‘Solid Add’ ‘ Ii

The result will be as below.
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Copy the Flute as a Pattern

If the solid’s feature tree is not already open, open it now by double-clicking on the
solid. The history tree shows all the operations you have used so far in constructing
the column.

From the tree, select the ‘Solid Add’ feature, by clicking it with the left mouse button.

Activate ‘General Edits’ \.‘.ﬁ}‘

: ‘ , DD
Click on ‘Pattern v

The default pattern type is a simple rectangular array. For this column we want a
circular layout.
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Delcam Designer

#1Solid Pattern Feature

X]

[ o L}’
Rectangular | Honeycpm@‘lir&frﬁme |

i L
Row alianment D.IJ-‘ »
[]Hollow Box Tile
Remove Feature Edit Defi
[ OK ] [ Cancel ] [ Help

Change the number of flutes to the value you want.

X]

@1 Solid Pattern Feature
| Rectangular || Hone')rcpmb| Circular |Wireframe!
__'a
B R
v (B ]
R ] o

- v
M
Elements
Rotation [[] centre element

m

Remove Feature

5

DK.' [ Cancel ] [ Help

10
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Click ‘OK’ when you are ready.

Twisting the Flutes

To make the flutes more interesting, we will twist the whole solid using Morphing.

Click the Solid Morph icon @

Point | Curve | Surface ({Flexible Box.

x Curve selected B FEH
“ [ Limit extent of morph

Fatent App. GB2401213
| Preview || oK |i Cancel I [ Help ]

Change to the ‘Flexible Box’ pages, then click ‘Twist'.

Issue Designer 7 11



Decorative Columns Delcam Designer

m

 Point | Curve | Surface | Flexible box |

v Select Faces Mumber of Slices
2¢  [OAround Workplane Anale I:I

® 8 § ®

Cancel ] [ Help ]

| Preview

‘Drag Handles’ will be drawn onto the solid, allowing you to control how the shape is
to be deformed. Grab the rotation handle at the bottom of the solid (it will already be
highlighted). Holding the mouse down, rotate the end as many times as you want.
Notice that this action is very dynamic, and that you can twist the shape through as
many revolutions as you wish. Note also that you can rotate in either direction, and
can also ‘rewind’.

When you are happy with the shape, simply let go of the mouse button.
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To finish, click OK.

@Morphing L 3

Point | Curve | Surface | Flexible box |
v Oselect Faces Mumber of Slices

3¢ [Oaround Workplane Anale I:I

B 8 & 8

T ok )| [ cancel | [ Help |
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Changing the Flutes

There are two feature-based changes that can be made at this stage.

Changing the Number of Flutes

Double-click the ‘Pattern’ feature in the history tree.

This will re-open the pattern form.
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Decorative Column

#1Solid Pattern Feature

| Rectangular | Hcrne*,rcnmbi Circular IWireframei

Elements
Rotation [%|v []centre element
| Edit Definition... |

t'ﬂ ) [ Cancel ] [ Help ]

Change the number of copies, and click OK. The solid will automatically update,

including the morph.

Changing the Flute Type

Next you will change the flutes from protrusions to cut-outs. Again, because the part

has been constructed from solid features, this is a very simple edit.

Issue Designer 7
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Decorative Columns

Double-click the initial solid Addition feature in the tree to open the edits form.

@1 Boolean Feature =3

..-'"'.\
~ | [Type of Boolean

Copy secondary solid

[] isplay primary and secondary salids

[ Replace Solid...

[ OK ][ Cancel ][ Help

Open the drop-down list marked ‘Type of Boolean'.

From the available list, select a Subtract feature.

@ Boolean Feature X

vpe of Boolean

- Copy secondary solid

[] Display primary and secondary solids

[ Replace Solid...

[ oK ][ Cancel ][ Help ]

Click OK, and the solid will update. Now, instead of the flutes being raised from the

surface of the column are cut out.

Issue Designer 7
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End of Tutorial

Optionally you may wish to create a rendered image.

Select everything (Ctrl + A)

Open the materials form - Tools M M

Style Dashed
Style Solid
Levels...

- Materials..
Archive Materials...
Transparency 4
Lights...

Labels...
Paint Triangles...
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Set the Material Type to Marble

@l Material Selection x|
Material Type Standard w Use Wireframe Colour
Iaterial for Standard Use Inside Colour
Metal
Layout E Cast Metal extures. .. | Delete
_ Coated Metal
Materials -

®

standard01standard0: 3

standard0f standardoe 3

standardl® standardie 3

standard?2: standard2? 5

[ ¢

Autumn
Glass
Metallic
Muted
MNeon
Pastel
Satin

Silk
Spring
Summer
Tropical
Winter
Leather
matt
Defaults
Textile
Skin
Transparent
Gems
Skin2
Textile2

tandard0® standard0¢ standard0’

tandardl: standardl: standardis

tandardl¢ standard2( standard21

- |»

btandard2¢ standard2;  Default

[ Help |

18
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-

2 Material Selection %

Marble v | []Use Wireframe Colour
Use Inside Colour

Material Type

Material for

Loy L

L [ Custom... ][ Textures... ] Delete

Materials

MrBluel  MrBlue2 MrBlue3 MrBluePoll MrBluePolz

O ok [ Cancel ][ Help

Open the Render Options page

Set the options as shown below.

# Render X
B

Image Quality

Presets Best

Method Ray trace full v
Shadow Soft b
Scenery

({ () Floor |

Image Resolution
(=) As View

{1 As Printer

) Custom
(" Standard

(] Automatic Up f'a.t.av

[ Render ]i oK /a[ Cancel H Help
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Note that when you click the ‘Change’ button on the Lights panel a new form will
open, allowing you to select the light studio you want to use.

-

#l Light Studio Selector B

Light Studio Groups Standard w

Light Studios

o ja e lo

Standard  StdLeft StdRight StdCentre

StdTop Sky

OK | | Cancel | | Help |
Set the view type to @ O @ @ H @
‘Enhanced’ : J
Finally, click the ‘Render’ icon. Q{

NOTE: Creating a rendered image using the ‘Sky’ lighting studio can take some time,
particularly in a full size window. When making rendered images of large, complex
scenes, it is worth making a test render in a smaller window first. This helps ensure
the final full-size render is correct, without wasting lots of time. A quick way to do this
is from the Render Options form. In the ‘Image Resolution’ panel, click the ‘Standard’
button, and choose an appropriate size. The rendered view will appear in the lower
left corner of the main view.

Save the model in D:\users\Training\Coursework\Delcam Designer Jobs as
Decorative Column.psmodel
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Exercise — A Guitar Body

Introduction

This tutorial will show how to construct the complex guitar body shown from existing
wireframe.

Key feature of this example —
Creating simple solids

Solid fillets

Flexibox morphing

Solid Boolean operations
Rendering
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Creating the Body

Open the model ‘Guitar’. (If it is not already on your computer click
‘Import’ and browse to the data folder that contains the model
(Guitar.psmodel)

The model contains 8 curves.

Make sure the working axis is Z. v | % ‘E@ i

Select the main outer profile, as shown G ﬁ
above, and make a solid extrusion. ]

Set the length of the extrusion to 45mm
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@ Extrusion

Dimensions | Waorkspace " Shetchl

Name
Length
Draft Angle

Activate solid filleting. 0
F|

Set the fillet radius to 10
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m

iy

Radius f‘. Variable
Follow Continuous Edges

Add Adjacent Continuous Surfa
CIFillet A Face

) Add all Continuous Surfaces
LIFillet Away From A Face

(9){e]

| Apply ||Advanced | [ Dismiss J[ Help ]

Select the two edges highlighted below. Click either edge with the left mouse button,
then SHIFT-Click the other to add it to the selection.

il By wOoeCcmYee
Radius Variable

Follow Continuous Edges
[IFillet A Face
[CIFillet Away From A Face

Add Adjacent Continuous Surfa

Add All Continuous Surfaces

Y

[ 9

/1?

When both edges are selected click the ‘Apply button’.

D

‘Dismiss’ the fillet form.
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Adding the Scratch Plate

)

Set the Height of the Boss to be 1mm, making sure that it points away from the
guitar body (i.e. it is protruding, not recessed). If necessary, click the ‘Reverse’
button to change the direction. When you are ready, click ‘OK'.

Select the curve highlighted above, and create a solid boss feature

Issue Designer 7 5



Guitar Body Delcam Designer

i)
=]

=
-

Extrude both directions

~ Sketch

Name artcams v
| Edit... | | Replace | | Delete |
X Relationship 23]

Add selected sketch
Add sketches from symbols

[ 1Group nested sketches

[v] Alternate nested draft angles
@r G ) (b
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Sculpting the Body using Morphing

The body is currently flat, and fairly uninteresting. Use the Morphing tools to make
the body much more exciting.

Start the Morphing tool by clicking C?

@ Morphing E

Point | Curve | Surfac
x Curve selected £
-0

Fatent Apbp. GB2401213

[ Cancel ][ Help ]

Select the Flexible Box (FlexiBox) tab.

Set the number of slices to 5 (to achieve finer control) and click the ‘scale’ icon.

# Morphing =3

Point | Curve SurFace| Flexible box

v Select Faces Number of Slices

[ Around Workplane

Anale

[ Cancel ][ Help ]

For the purposes of this tutorial example, the body was morphed in four stage as
shown below. To select a different ‘plane’ to work on, select one of the BLUE grab
handles on the instrumentation box.
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Feel free to experiment with your own shape.

When you are happy with the result, click OK.

m

' Point | Curve | Surface | Flexible bDX]

( []Select Faces Murmber of Slices
3¢ [Around Workplane Ariale I:I

B 8 E®

[T] Cancel [ Help J
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Creating the Cutouts

To finish the guitar body several cutouts are needed, to accommodate fitting the
neck and the electronics.

Select the four rectangular curves shown below. (Use the shift button to multi-select)

Use solid ‘Cut’ to remove unwanted material. E
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Delcam Designer

e [ind v

~ Extrusion
Depth | 693.6

[ ]Reverse
[ Extrude both directions

~ Sketch

Mame artcami

| Edit... || Replace |[_Delete

X Relationship [

Add selected sketch
Add sketches from symbols
Remove inside material

[ 1Group nested sketches
Alternate nested draft angles

oK cancel || Help

|

12
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The solid cut features in the back of the guitar must be made separately as they are
different depths, although they can be done in any order. Also note that the exact
depths you use will probably be different from those shown here, due to differences
in the morphing.

For the inner circle (smaller) enter a depth of 45

‘@solidcet &

[]JReverse

[] Extrude both directions

~Sketch

tome. |33
Edit... Replace Delete

3¢ relationship

B3 Add selected sketch
Add sketches from symbols

Remove inside material
[l Group nested sketches
Alternate nested draft angles
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Delcam Designer

For the outer circle, enter a depth of 6

|

[]Extrude both directions

Type Blind Ly
~ Extrusion

Depth 6 |

Angle 0

[JReverse

~ Sketch .
Name |3.?r
| Edit... || Replace || Delete |

3¢ relationship

[0 Add selected sketch
Add sketches from symbols

Remove inside material
[] Group nested sketches
Alternate nested draft angles

0K Cancel | [ Help

J
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Rendering the Finished Body

Render the part using two different materials, one for the body, and a separate one
for the scratchplate. To do this, you must first convert the solid back to its constituent
surfaces.

Solid 1 {General)

Cut
Copy

Faste
Faste Specia

Delete

Mext Selection
Clear Selection
Select All

Blank
Blank Except

Undo
Redo

Selection Information

Convert

Copy All Surfaces
Modify...

Select the entire model, and pick a nice material, for example —
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@ Material Selection X
Material Type Winter + | []Use Wireframe Colour
[aterial for Use Inside Colour
Layout [ Custom... ] [ Textures... ] Delete
Materials

Winter0l Winter02 Winter03 Winter04 Winter0s Winter0e Winterd7

Winter08 Winter09 Winterld Winterll Winterl2 Winterl3d Winterld

VOO _owo

Winterls Winterld Winterl? Winterl8 Winterl9 Winter21

0o

Winter22 Winter23 Winter24 Winter2

Winter2a Winter23d

[ 0K ][ Cancel ][ Help ]

Now deselect everything (either left-click somewhere away from the model, or press
Ctrl + D).

Select the scratchplate surface, and choose another material.
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r E—
Material Type [Juse Wireframe Colour

Material for Whole solid [ Use Inside Colour
Layout... [ Custom... ] [ Textures... ] Delete
~Materials

oo @
" |ooro e
- oo

Lead Vaanesiumr Mercury
GoldSatin SilverCast SilverSatin  Gold9ct

ok J[ cancel J[ Hep |

Click OK.

A rendered view (with default lighting) will look like this —

Save the model in D:\users\Training\Coursework\Delcam Designer Jobs as
Guitar exercise.psmodel
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Exercise — A 3D Scroll

Introduction

This tutorial teaches you how to make the complex 3D scroll shown above.

Key features covered in this tutorial are —
Surface manipulation

Curve editing

Surface creation

Pasting surfaces into AtCAM Jewelsmith
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Creating a Surface to Sketch On

The main profile of the scroll is quite complex, and unlike most of the sketches you
have created so far is non-planar. To create the sketch you will first make a simple
surface. The exact dimensions are not critical for any part of this tutorial, and you
should feel free to use your own artistic judgement.

Create a workplane 2» at0,0,0

Click

Create a planar surface
below.

0 (plane primitive) at about -65 in the X axis as

Change the plane so that it exactly meets the centre-line. l.e. If your plane is centred
at -65 it must be 130 wide.

2 Issue Designer 7



Delcam Designer

3D Scroll

If necessary, adjust the ‘Y’ dimension of the plane as well.

Click on the surface
Using the right hand
mouse button to open
the surface edit pop-up
and select ‘Convert
Surface’. This will change
the surface to a
PowerSURFACE, and let
you do more complex
editing.

Surface Plane 1 (General)

Paste
Paste Special
Delete

MNext Selection
Clear Selection
Select all

Blank
Blank Except

Undo
Redo
Selection Information

Fename...

Define morph
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Select the surface at the point shown, making sure the hightlighting is drawn exactly

as in the image below. This shows that you are ready to Edit a single Point on the
surface.

Press the left hand mouse key, and the Ctrl key at the same time and hold them
down. Draw the selected point as shown to add a new curve into the surface.
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NOTE: Take care to only add a single curve, in the direction shown.

Select the point shown below.

The surface will next be deformed by moving this point along the Z axis. How far you
move it is entirely up to your artistic judgement.

Set the working axis to Y
PO
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.
Make sure ‘Smooth Adjacent Spans’ is ON ¢ g @ ‘

While holing the ‘Z’ key down, drag the highlighted point upwards. Note that holding
down ‘Z’ forces the point to move along the Z axis only.

Select the point on the opposite corner, as shown below.
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This point will be Offset along the normal. (The vector that is perpendicular to a
surface).

Press the Crtl key on your keyboard and hold it down. (You can release the mouse).
Now press the Up Arrow key. The surface will continue to change shape as long as
you hold the arrow key down. When you are happy with the shape, release the arrow
key. Note that if you wish, you can press the Down Arrow key to reverse the
direction.

The end result will look like this —

View the surface from above by pressing Ctrl + 5.
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Creating the Main Curve

Sketch a Bezier curve similar to the one shown below. Note that as you sketch the
cursor is displaying the key-word ‘IN’. This means that each point that forms the
curve lies exactly on the surface. Note, though, that the spans between the points
may not lie exactly on the surface for all their length.

Delete the surface, leaving just the curve.

Rotate the view a little, and select the Curve.
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Open the General Edits page @

Click on Mirror/Symmetrise ﬁ

2 EE S

Symmetrise the curve through YZ, *=——==———— then press

With the new curve still selected, click I‘-‘»
the Append Curve option from the curve q ﬁ w ) ¢
edit toolbar. = —

Select the original curve, and then click OK
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Note that there is a slight discontinuity at the mid-point of the curve, which must be
corrected before proceeding.

Select the mid-point so it highlights.

Remove the point by clicking c& (on the surface/curve toolbar)
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Press Ctrl + 2 to view the model along the Y axis.

Select the curve, and make a mirror copy through XY.

Drag (move) the highlighted curve along the Z axis so it looks as below. (The exact
value is unimportant).
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Creating the Surface

Select both curves.

Open the Surface Creation toolbar ‘9

£y
Click ‘Automatic Surfacing’ *a

The new surface is produced automatically, so all you need do is click OK.

‘@ Automatic Surfacing 4

~Surface Type————————— ~Method
(%) PowerSurface(s)
) NURBS

~ Options
Automatic Previewing

[ | Tangent to Surface(s)

. | From Separate El H
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Save the model in D:\users\Training\Coursework\Delcam Designer Jobs as
Scroll exercise.psmodel

Passing the Scroll to ArtCAM

Make sure the surface is selected, and then copy the surface to the h
clipboard.

Open ArtCAM JewelSmith.

Create a New Project '

Right click on Assembly in the Project tree and select
Paste.

Paste the surface into the Project.
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